Preface

This study guide and technology manual is designed to accompany Essentials of Marketing Research, First Edition, by Naresh K. Malhotra. It has been prepared to help students learn and practice chapter material, prepare for exams, approach comprehensive cases, and utilize statistical software.

This manual is divided into three major parts. In the study guide portion, you will find learning objectives, an outline of text material, ten true-false questions, ten multiple choice questions, and hints for selected applied problems for each of the nineteen chapters. The case analysis section provides hints for selected questions for all the comprehensive cases presented at the end of the textbook. The technology manual section presents a statistical database derived from a marketing research study for a financial institution. It poses a series of questions related to the statistical approaches presented in the text. The procedures for addressing these questions are illustrated for four alternative statistical software packages: SPSS, Excel, Minitab, and SAS. A dataset is available for each located at http://www.pearsonhighered.com/malhotra.

I want to acknowledge, with great respect, my parents, the late Mr. H. N. Malhotra, and Mrs. S. Malhotra. Their love, encouragement, support, and the sacrificial giving of themselves have been exemplary. My heartfelt love and gratitude go to my wife Veena, and my children Ruth and Paul, for their faith, hope, and love.

Most of all, I want to acknowledge and thank my Savior and Lord, Jesus Christ, for the abundant grace and favor He has bestowed upon me. This book is, truly, the result of His favor—“For thou, LORD, wilt bless the righteous; with favor wilt thou compass him as with a shield” (Psalms 5:12). I praise God and give Him all the glory. Undoubtedly, the most significant event in my life was when I accepted the Lord Jesus Christ as my personal Savior and Lord. “For whosoever shall call upon the name of the Lord shall be saved “(Romans 10:13).

Naresh K. Malhotra

Copyright © 2015 Pearson Education, Inc.
# Table of Contents

**Student Resource Manual**

- Chapter 1  Introduction to Marketing Research .............................................................1
- Chapter 2  Defining the Marketing Research Problem and Developing an Approach .............................................................8
- Chapter 3  Research Design, Secondary and Syndicated Data........................................17
- Chapter 4  Qualitative Research ..................................................................................33
- Chapter 5  Survey and Observation ............................................................................42
- Chapter 6  Experimentation .........................................................................................49
- Chapter 7  Measurement and Scaling ........................................................................56
- Chapter 8  Questionnaire and Form Design ................................................................66
- Chapter 9  Sampling Design and Procedures ...............................................................76
- Chapter 10 Data Collection and Preparation ...............................................................90
- Chapter 11 Data Analysis: Frequency Distribution, Hypothesis Testing, and Cross-Tabulation .............................................................101
- Chapter 12 Data Analysis: Hypothesis Testing Related to Differences, Correlation and Regression ...........................................................................................................109
- Chapter 13 Report Preparation and Presentation.......................................................116
- Answer Key .................................................................................................................122

**Cases**

- Case 1.1 Dell Direct........................................................................................................130
- Case 2.1 American Idol: A Big Hit for Marketing Research? ....................................132
- Case 3.1 JPMorgan Chase: Chasing Growth Through Mergers and Acquisitions 134
- Case 3.2 Wendy’s: History and Life After Dave Thomas .............................................136

Copyright © 2015 Pearson Education, Inc.
Technology Manual

FFFCU Example Database. .................................................................138
Research Questions.................................................................139
SPSS.........................................................................................141
Excel .................................................................158
CHAPTER 1

INTRODUCTION TO MARKETING RESEARCH

LEARNING OBJECTIVES

1. Define marketing research and distinguish between problem identification and problem-solving research.
2. Describe a framework for conducting marketing research as well as the six steps of the marketing research process.
3. Understand the nature and scope of marketing research and its role in designing and implementing successful marketing programs.
4. Explain how the decision to conduct marketing research is made.
5. Discuss the marketing research industry and the types of research suppliers, including internal, external, full-service, and limited-service suppliers.
6. Describe careers available in marketing research and the backgrounds and skills needed to succeed in them.
7. Explain the role of marketing research in decision support systems.
8. Acquire an appreciation of the international dimension and the complexity involved in international marketing research.
9. Describe the use of social media as a domain to conduct marketing research.
10. Gain an understanding of the ethical aspects of marketing research and the responsibilities each of the marketing research stakeholders have to themselves, one another, and the research project.

CHAPTER OUTLINE

1. Overview
2. Definition of Marketing Research
3. A Classification of Marketing Research
4. Marketing Research Process
5. The Role of Marketing Research in Marketing Decision Making
6. The Decision to Conduct Marketing Research
7. An Overview of the Marketing Research Industry
8. Selecting a Research Supplier
9. Careers in Marketing Research
10. The Role of Marketing Research in MIS and DSS
11. International Marketing Research
12. Social Media and Marketing Research
13. Ethics in Marketing Research

Copyright © 2015 Pearson Education, Inc.
LEARNING TIPS

Focus on the issues identified in the following for each learning objective.

Learning Objective 1

* Definition of marketing research.
* Classifications of marketing research.

* Figure 1.2 displays this classification scheme.

Learning Objective 2

* Steps involved in the marketing research process.

Learning Objective 3

* The nature of marketing research.

Learning Objective 4

* Considerations that guide the decision to conduct marketing research.

Learning Objective 5

* Describe the two types of marketing research suppliers.

* Figure 1.5 shows this classification.
Learning Objective 6

* Skills required for a successful career in marketing research.

Learning Objective 7

* The relationship between marketing research and MIS.
* The relationship between marketing research and decision support systems (DSS).

* Figure 1.6 explains the development of MIS and DSS. It may be helpful here.

Learning Objective 8

* The importance and difficulties of international marketing research.

Learning Objective 9

* The use of social media as a domain to conduct marketing research.

Learning Objective 10

* The ethical considerations relevant to the four stakeholders in marketing research.

* See Figure 1.8.

TRUE/FALSE QUESTIONS

1. Problem-identification research is seldom used to address pricing issues.

2. According to the text, problem-solving research is seldom used to assess the environment and diagnose problems.

3. Segmentation is an example of a topic typically addressed by problem-solving research.
4. The third step of six steps in any marketing research project is to formulate the research design.

5. Limited service suppliers specialize in one or a few steps of the marketing research process.

6. Technology is considered an uncontrollable environmental factor.

7. M/A/R/C would be an example of marketing research firm mentioned in the text.

8. Outside marketing research companies hired to supply marketing research data are called external supporters.

9. According to the text, most research suppliers are small firms.

10. Companies that collect and sell common pools of data designed to serve information needs that a number of clients share are called customized services.

**MULTIPLE CHOICE QUESTIONS**

1. Which of the following statements are TRUE about marketing research?
   a. marketing research follows a predictable path.
   b. marketing research is systematic.
   c. marketing research can be planned.
   d. marketing research is a process
   e. all of the answer selections are true.

2. Problem-identification research is typically used to address all of the following topics EXCEPT:
   a. market share
   b. short-range forecasting
   c. long-range forecasting
   d. market potential
   e. all of the above are true

3. All of the following are examples of topics typically addressed by problem-solving research EXCEPT:
   a. segmentation
   b. product
   c. promotion
   d. long-range forecasting
   e. pricing
4. Which of the following is NOT a step in the marketing research process?
   a. problem definition
   b. systematic intervention
   c. research design formulation
   d. report generation and presentation
   e. fieldwork

5. Determining the management decision problem in any marketing research project occurs in this step:
   a. define the problem
   b. develop an approach to the problem
   c. formulate the research design
   d. correct the problem
   e. excise the problem

6. Which of the following is a form of interviewing that can be used in the data collection state of the research process?
   a. telephone interviewing
   b. mail interviewing
   c. electronic interviewing
   d. personal interviewing
   e. all of the above are correct

7. Which of the following is NOT considered an uncontrollable environmental factor?
   a. competition
   b. social and cultural factors
   c. political factors
   d. pricing strategy
   e. economy

8. Which of the following are considered to be controllable marketing variables?
   a. competition
   b. technology
   c. promotion
   d. distribution
   e. c and d above

9. Which of the following is the best description for firms that fundamentally collect data, using a wide range of data collection methods?
   a. technical service
   b. analytical service
   c. field service
   d. qualitative service
   e. none of the above
10. Marketing research departments located within a firm are called ______.
   a. providers
   b. horizontal suppliers
   c. virtual suppliers
   d. external suppliers
   e. none of the above

HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES

1-16. Consider some of the examples in Figure 1.2.

1-17. For each organization, many types of marketing research are appropriate. Consider some of the examples in Figure 1.2

1-20. Make sure that you look carefully at each of these three web sites, MRA (www.mra-net.org), ESOMAR (www.esomar.nl), and AMSRS (www.amsrs.com.au) in terms of the usefulness of the information to marketing research suppliers in conducting marketing research and usefulness to marketing managers in using marketing research.

1-21. You’ll need to look at a number of different sources. You should find that the current and future market potential for the marketing researchers is high.

EXTRA MATERIALS
CHAPTER 2

DEFINING THE MARKETING RESEARCH PROBLEM AND DEVELOPING AN APPROACH

LEARNING OBJECTIVES

1. Understand the importance of and process used for defining the marketing research problem.

2. Describe the tasks involved in problem definition including discussion with decision maker(s), interview with industry experts, secondary data analysis, and qualitative research.

3. Discuss the environmental factors affecting the definition of the research problem: past information and forecasts; resources and constraints; objectives of the decision maker; buyer behavior; legal environment; economic environment; and marketing and technological skills of the firm.

4. Clarify the distinction between the management decision problem and the marketing research problem.

5. Explain the structure of a well-defined marketing research problem including the broad statement and the specific components.

6. Discuss in detail the various components of the approach: analytical models, research questions and hypotheses, and identification of the information needed.

7. Acquire an appreciation of the complexity involved in defining the problem and developing an approach in international marketing research.

8. Describe how social media can be used to identify and define the marketing research problem and aid in developing an approach.

9. Understand the ethical issues and conflicts which arise in defining the problem and developing the approach.

CHAPTER OUTLINE

1. Overview
2. The Importance of Defining the Problem  
3. The Process of Defining the Problem and Developing an Approach  
4. Tasks Involved  
   i. Discussion with Decision Makers  
   ii. Interviews with Industry Experts  
   iii. Secondary Data Analysis  
   iv. Qualitative Research  
5. Environmental Context of the Problem  
   i. Past Information and Forecasts  
   ii. Resources and Constraints  
   iii. Objectives of the Decision Maker  
   iv. Buyer Behavior  
   v. Legal Environment  
   vi. Economic Environment  
   vii. Marketing and Technological Skills  
6. Management Decision Problem and Marketing Research Problem  
7. Defining the Marketing Research Problem  
8. Components of the Approach  
   i. Analytical Framework and Models  
   ii. Research Questions and Hypotheses  
   iii. Specification of Information Needed  
9. International Marketing Research  
10. Social Media and Marketing Research  
11. Ethics in Marketing Research  
12. Summary  
13. Key Terms and Concepts  
14. Acronyms  

LEARNING TIPS  
Focus on the issues identified in the following for each learning objective.  

Learning Objective 1  
* The problem definition process.  
  
  *Figure 2.2 can be used as a guideline to the problem definition process.*  

Learning Objective 2
* The difficulties of dealing with the decision maker (DM).
* The role of industry experts and secondary data in identifying problem(s).
* The role of qualitative research in the process of developing an approach.

**Learning Objective 3**

* The environmental factors affecting the problem definition process.

*Figure 2.4 may be helpful here by listing the environmental factors marketers should consider.*

**Learning Objective 4**

* Distinguish between the marketing research problem and management decision problem.

**Learning Objective 5**

* Components of a well-defined marketing research problem.

**Learning Objective 6**

* Objective/theoretical foundations.
* Analytical models.
* Research questions and hypothesis.
* Identification of information needed.

*Figure 2.8 may be helpful here as a guideline to see the flow of development from research questions to hypotheses.*

**Learning Objective 7**
* The importance of taking into account the environmental factors when defining the problem in a foreign market.

**Learning Objective 8**

* The role of social media in defining the marketing research problem and in developing an approach.

**Learning Objective 9**

* The ethical responsibilities of the researcher and the client.

**TRUE/FALSE QUESTIONS**

1. While every step in a marketing research project is important, problem definition formulation is the most important step.

2. According to the text, secondary data are an economical and quick source of background information.

3. Pilot surveys typically contain more open-ended questions than large-scale surveys.

4. Case studies usually involve written cases, found in business textbooks.

5. An unstructured, exploratory research methodology based on small samples intended to provide insight and understanding of the problem setting is called qualitative research.

6. Focusing on the symptoms of a problem is a characteristic of a management decision problem.

7. Unbiased evidence that is supported by empirical findings is called subjective evidence.

8. According to the text, mathematical models are logical, preliminary steps to developing graphical models.

9. An unproven statement or proposition about a factor or phenomenon that is of interest to the researcher is called a hypothesis.

10. Hypotheses are statements that cannot be empirically tested or verified.
MULTIPLE CHOICE QUESTIONS

1. The first step in the marketing research project should be ____.
   a. problem definition
   b. problem correction
   c. research design formulation
   d. report generation and presentation
   e. project completion

2. The ____ involves discussions with the decision maker on the history of the problem, the criteria that will be used to evaluate the alternative courses of action, the information that is needed to answer the decision maker's questions, and the alternative courses of action available to the decision maker.
   a. problem definition
   b. problem correction
   c. hypotheses generation
   d. research directive
   e. problem audit

3. ____ are data generally collected by an outside source.
   a. Primary data
   b. Secondary data
   c. Virtual data
   d. Observational data
   e. Research data

4. All of the following represent examples of sources of secondary data EXCEPT:
   a. trade organizations
   b. the Bureau of Census
   c. the Internet
   d. a and b above
   e. experience surveys

5. According to the text, examples of cases used in case studies could be all of the following EXCEPT:
   a. customers
   b. stores
   c. firms
   d. markets
   e. secondary data

6. The researcher must have a clear understanding of two types of objectives. Objectives:
   a. of the organization
   b. of the decision maker
   c. of the consumer
d. a and b above
e. a and c above

7. All of the following are considered as elements in the economic environment EXCEPT:
   a. patents
   b. purchasing power
   c. discretionary income
   d. general economic conditions
   e. disposable income

8. A(n) ____ is a conceptual scheme based on foundation statements, which are assumed to be true.
   a. experiment
   b. objective
   c. incident
   d. investigation
   e. none of the above is correct

9. Which of the following is a common form of a model in marketing research?
   a. verbal model
   b. graphical model
   c. mathematical model
   d. historical model
   e. human model

10. An unproved statement or proposition about a factor or phenomenon that is of interest to the researcher is called a(n) ____.
    a. theory
    b. model
    c. experiment
    d. invoice
    e. none of the above is correct

HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES

1. Focus on the implications for marketing of population trends by age groups in the US.

2-14. Use Tables 2.2 and 2.3 as a guide

2-15. Use Tables 2.2 and 2.3 as a guide

2-16. Make sure that you clearly differentiate symptoms from causes.
2-18. There are many on-line databases which can be used. Focus on reports or studies dealing with how passengers select which airline to fly.

2-20. There are many online databases which can be used, including your library’s online database, to obtain information on the annual sales of the firm and the industry for the last seven years.

2-21. While this list of choice criteria factors for sneakers may not be comprehensive, it should be illustrative and include factors such as type of upper, type of sole, price, image, type of technology, etc.

EXTRA MATERIALS

The Problem Audit
The problem audit is a comprehensive examination of a marketing problem with the purpose of understanding its origin and nature.

1. The events that led to the decision that action is needed; the history of the problem.

2. The alternative courses of action available to the DM.

3. The criteria that will be used to evaluate the alternative courses of action.

4. The potential actions that are likely to be suggested based on the research findings.
The Problem Audit (Cont.)

5. The information that is needed to answer the DM's questions.

6. The manner in which the DM will use each item of information in making the decision.

7. The corporate culture as it relates to decision making.

Figure
Conducting a Problem Audit

- History of the Problem
- Alternative Courses of Action Available to DM
- Criteria for Evaluating Alternative Courses
- Nature of Potential Actions Based on Research
- Information Needed to Answer the DM's Questions
- How Will Each Item of Information Be Used by the DM?
- Corporate Decision-Making Culture
CHAPTER 3
RESEARCH DESIGN, SECONDARY AND SYNDICATED DATA

LEARNING OBJECTIVES

1. Define and classify various research designs, and explain the differences between exploratory and conclusive research.
2. Define the nature and scope of secondary data and distinguish secondary data from primary data.
3. Analyze the advantages and disadvantages of secondary data and their uses in the various steps of the marketing research process.
4. Evaluate secondary data using the criteria of specifications, error, currency, objectives, nature, and dependability.
5. Describe in detail the different sources of secondary data, including internal sources and external sources.
6. Discuss in detail the syndicated sources of secondary data, including household/consumer data obtained via surveys, mail panels, and electronic scanner services, as well as institutional data related to retailers, wholesalers, and industrial/service firms.
7. Explain the need to use multiple sources of secondary data and describe single-source data.
8. Discuss research design formulation, and identify and evaluate the sources of secondary and syndicated data useful in international marketing research.
9. Discuss how the analysis of social media content can facilitate the research design process and the collection of secondary and syndicated data.
10. Understand the ethical issues involved in the formulation of research design and the use of secondary and syndicated data.

CHAPTER OUTLINE

1. Overview
2. What is a Research Design?
3. Basic Research Designs
4. Exploratory Research
5. Descriptive Research
   i. Cross-Sectional Design
   ii. Longitudinal Design
6. Causal Research
7. Primary versus Secondary Data
8. Advantages and Disadvantages of Secondary Data
9. Criteria for Evaluating Secondary Data
   i. Specifications: Methodology Used to Collect the Data
   ii. Error: Accuracy of the Data
   iii. Currency: When the Data Were Collected
   iv. Objective(s): The Purpose for the Study
   v. Nature: The Content of the Data
   vi. Dependability: Overall, How Dependable Are the Data
10. Classification of Secondary Data
11. Internal Secondary Data and Database Marketing
    i. Customer Databases
    ii. Data Warehousing and Data Mining
    iii. CRM and Database Marketing
12. External Secondary Data
    i. Business/Nongovernmental Data
    ii. Government Sources
       a. Census Data
       b. Other Government Sources
13. The Nature of Syndicated Data
14. A Classification of Syndicated Services
15. Surveys
    i. Periodic surveys
    ii. Panel surveys
    iii. Psychographics and Lifestyles
    iv. Advertising Evaluation
    v. General surveys
    vi. Uses, Advantages and Disadvantages of surveys
16. Purchase and Media Panels
    i. Purchase Panels
    ii. Media Panels
    iii. Uses, Advantages and Disadvantages of Purchase and Media Panels
17. Electronic Scanner Services
    i. Volume-Tracking Data
    ii. Scanner Panel Data
    ii. Scanner Panels with cable TV
    iv. Uses, Advantages and Disadvantages of Scanner Data
18. Syndicated Services for Institutional data
    i. Retailer and Wholesaler Audits
       a. Uses, Advantages and Disadvantages of Audit Data
    ii. Industry Services
       a. Uses, Advantages and Disadvantages of industry Services
19. Combining Information from Different Sources: Single Source Data
20. How to Conduct an Online Search for External Secondary Data
21. International Marketing Research
22. Marketing Research and Social Media
LEARNING TIPS

Focus on the issues identified in the following for each learning objective.

Learning Objective 1

* Exploratory and conclusive research designs.

* Explain the differences between descriptive and causal research.

* Classify descriptive research into cross-sectional and longitudinal designs.

Learning Objective 2

* Discuss the nature of secondary data.

Learning Objective 3

* Identify the Advantages of secondary data.

* Identify the disadvantages of Secondary data.
**Learning Objective 4**

* The criteria for evaluating the quality of secondary data.

**Learning Objective 5**

* Internal sources of secondary data.
* Data warehousing and data mining.
* Customer relationship management and database marketing.
* Government census data as a major source of secondary data.

**Learning Objective 6**

* Syndicated sources of secondary data.
* Various methods of obtaining household data.
* Various methods of obtaining institutional data.

**Learning Objective 7**

* The need to use multiple sources of secondary data.

**Learning Objective 8**

* Difficulties associated with environmental differences in international research.
* Syndicated firms with significant international operations.

**Learning Objective 9**
* Discuss how social media can facilitate the implementation of the various research designs.

* Discuss social media as a valuable source of secondary data.

See Figure 3.6; social media can be a rich source of both internal as well as external secondary data.

**Learning Objective 10**

* Ethical concerns pertaining to research design.

* Ethical situations pertaining to secondary data.

* Discuss the ethical issues involved in collection syndicated data.

**TRUE/FALSE QUESTIONS**

1. A type of research design that has as its primary objective the provision of insight into and comprehension of the problem situation confronting the researcher is called causal research.

2. Exploratory research should be used when management realizes a problem exists but does not yet understand why.

3. According to the text, the objective of causal research is to test specific hypotheses and examine specific relationships.

4. Exploratory research is typically less formal and structured than conclusive research.

5. Primary data is data originated by the researcher for the specific purpose of addressing the research problem.

6. Secondary data represents any data that have already been collected for purposes other than the problem at hand.

7. Compared to the collection cost of primary data, secondary data is typically less expensive.

8. Syndicated services make their money by collecting data and designing research products that fit the information needs of more than one organization.
9. Interviews with a large number of respondents using a predesigned questionnaire are called scanner panels.

10. Syndicated services offer customized marketing research.

**MULTIPLE CHOICE QUESTIONS**

1. ________ is research conducted to define the problem and identify possible courses of action.
   a. Exploratory research
   b. Conclusive research
   c. Descriptive research
   d. Causal research
   e. Directed research

2. Large, representative samples are often used in ________.
   a. conclusive research
   b. subjective research
   c. exploratory research
   d. observational research
   e. conditional research

3. ________ research is typically less formal and structured than ________ research.
   a. Exploratory; conclusive
   b. Conclusive; exploratory
   c. Exploratory; qualitative
   d. Subjective; observational
   e. None of the above is correct

4. Compared to the collection cost of secondary data, primary data is _____.
   a. more expensive
   b. approximately the same cost
   c. less expensive
   d. nonexistent
   e. more elusive

5. Which of the following is NOT mentioned in the text as a primary criterion for evaluating secondary data?
   a. specifications
   b. error
   c. currency
   d. cost
   e. objective (why were the data collected?)
6. An overall indication of the dependability of the data may be obtained by examining all of the following EXCEPT:
   a. the expertise of the source
   b. the reputation of the source
   c. the trustworthiness of the source
   d. the location of the source
   e. the source being the original source rather than an acquired source.

7. Social media are a source of:
   a. internal secondary data
   b. objective data
   c. external secondary data
   d. a and c
   e. a, b and c

8. _____ collect data on the same set of variables at regular intervals, each time sampling from a new group of respondents.
   a. Panel surveys
   b. Multiple surveys
   c. Parallel surveys
   d. Regular surveys
   e. None of the above is correct

9. Which of the following companies is recognized as a large syndicated firm?
   a. Nielsen
   b. Microsoft
   c. Apple
   d. all of the above (a, b, and c) are correct
   e. None of the above is correct

10. _____ provide secondary data derived from industrial sources that are intended for industrial use.
    a. Single-source services
    b. Customized services
    c. Retail services
    d. Movement services
    e. None of the above is correct.

**HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES**

3-20. Table 3.1 shows a comparison of research designs.
3-21. This information can be obtained from a variety of Internet sources.

3-22. You may find that the two estimates are not identical.

3-28. Use the framework of Figure 3.8.

3-29. Use the framework of Figure 3.8.

EXTRA MATERIALS

Tasks Involved In a Research Design

- Secondary and Syndicated Data Analysis
- Qualitative Research
- Survey and Observation Research
- Experimental Research
- Measurement and Scaling Procedures
- Questionnaire and Form Design
- Sampling Process and Sample Size
- Plan of Data Analysis
Major Types of Descriptive Studies

Descriptive Studies

- Sales Studies
  - Market Potential
  - Market Share
  - Sales Analysis

- Consumer Perception and Behavior Studies
  - Image
  - Product Usage
  - Advertising
  - Pricing

- Market Characteristic Studies
  - Distribution
  - Competitive Analysis

Some Alternative Research Designs

- Exploratory Research
  - Secondary Data Analysis
  - Focus Group

- Conclusive Research
  - Descriptive/Causal

- Exploratory Research
  - Secondary Data Analysis
  - Focus Group

- Conclusive Research
  - Descriptive/Causal

Copyright © 2015 Pearson Education, Inc.
Geographic Subdivision of an MSA

A Classification of Computerized Databases

Computerized Databases

Online

Internet

Offline

Bibliographic Databases

Special Purpose Databases

Numeric Databases

Full-Text Databases

Directory Databases
Classification of Computerized Databases

- **Bibliographic databases** are composed of citations to articles.
- **Numeric databases** contain numerical and statistical information.
- **Full-text databases** contain the complete text of the source documents comprising the database.
- **Directory databases** provide information on individuals, organizations, and services.
- **Special-purpose databases** provide specialized information.

Classification of Syndicated Survey Research

- **Surveys by Syndicated Firms**
  - **Periodic**
  - **Panel**
    - **Psychographic and Lifestyles**
    - **Advertising Evaluation**
    - **General**
### Overview of Syndicated Services

<table>
<thead>
<tr>
<th>Type</th>
<th>Characteristics</th>
<th>Advantages</th>
<th>Disadvantages</th>
<th>Uses</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Surveys</strong></td>
<td>Surveys conducted at regular intervals</td>
<td>Most flexible way of obtaining data; information on underlying motives</td>
<td>Interviewer errors; respondent errors</td>
<td>Market segmentation; advertising theme selection, and advertising effectiveness</td>
</tr>
<tr>
<td><strong>Purchase Panels</strong></td>
<td>Households provide specific information regularly over an extended period of time; respondents asked to record specific behaviors as they occur</td>
<td>Recorded purchase behavior can be linked to the demographic/psychographic characteristics</td>
<td>Lack of representativeness; response bias; maturation</td>
<td>Forecasting sales, market share, and trends; establishing consumer profiles, brand loyalty, and switching; evaluating test markets, advertising, and distribution</td>
</tr>
<tr>
<td><strong>Media Panels</strong></td>
<td>Electronic devices automatically recording behavior, supplemented by a diary</td>
<td>Same as purchase panel</td>
<td>Same as purchase panel</td>
<td>Establishing advertising rates; selecting media program or air time; establishing viewer profiles</td>
</tr>
<tr>
<td><strong>Scanner Volume Tracking Data</strong></td>
<td>Household purchases are recorded through electronic scanners in supermarkets</td>
<td>Data reflect actual purchases; timely data; less expensive</td>
<td>Data may not be representative; errors in recording purchases; difficult to link purchases to elements of marketing mix other than price</td>
<td>Price tracking, modeling; effectiveness of in-store modeling</td>
</tr>
</tbody>
</table>

Copyright © 2015 Pearson Education, Inc.
### Overview of Syndicated Services (Cont.)

<table>
<thead>
<tr>
<th>Type</th>
<th>Characteristics</th>
<th>Advantages</th>
<th>Disadvantages</th>
<th>Uses</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scanner Diary Panels with Cable TV</strong></td>
<td>Scanner panels of households that subscribe to cable TV</td>
<td>Data reflect actual purchases; sample control; ability to link panel data to household characteristics</td>
<td>Data may not be representative; quality of data limited</td>
<td>Promotional mix analyses; copy testing; new-product testing; positioning</td>
</tr>
<tr>
<td><strong>Audit Services</strong></td>
<td>Verification of product movement by examining physical records or performing inventory analysis</td>
<td>Relatively precise information at the retail and wholesale levels</td>
<td>Coverage may be incomplete; matching of data on competitive activity may be difficult</td>
<td>Measurement of consumer sales and market share; competitive activity; analyzing distribution patterns; tracking of new products</td>
</tr>
</tbody>
</table>

### Overview of Syndicated Services (Cont.)

<table>
<thead>
<tr>
<th>Type</th>
<th>Characteristics</th>
<th>Advantages</th>
<th>Disadvantages</th>
<th>Uses</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Institutional Syndicated Services</strong></td>
<td>Data banks on industrial establishments created through direct inquiries of companies, clipping services, and corporate reports</td>
<td>Important source of information on industrial firms; particularly useful in initial phases of the projects</td>
<td>Data is lacking in terms of content, quantity, and quality</td>
<td>Determining market potential by geographic area; defining sales territories; allocating advertising budget</td>
</tr>
</tbody>
</table>

Combining data from different syndicated sources compensates for the weaknesses of one method with the strengths of another.
Single-Source Data Application

Single-source data are used by consumer packaged goods companies, like P&G, to design integrated marketing programs for households.

Sources of Secondary Data for Int’l Marketing Research

International Secondary Data

Domestic Organizations in the United States

Government Sources

International Organizations in the United States

Nongovernment Sources

Organizations in Foreign Countries

Governments

Trade Associations

International Organizations
CHAPTER 4

QUALITATIVE RESEARCH

LEARNING OBJECTIVES

1. Explain the difference between qualitative and quantitative research in terms of the objectives, sampling, data collection and analysis, and outcomes.
2. Understand the various forms of qualitative research including direct procedures such as focus groups and depth interviews, and indirect methods such as projective techniques.
3. Describe focus groups in detail with emphasis on planning and conducting focus groups, and their advantages, disadvantages, and applications.
4. Describe depth interview techniques in detail citing their advantages, disadvantages, and applications.
5. Explain projective techniques in detail and discusses their advantages, disadvantages and applications.
6. Discuss the considerations involved in conducting qualitative research in an international setting.
7. Discuss the use of social media in obtaining and analyzing qualitative data.
8. Understand the ethical issues involved in conducting qualitative research.

CHAPTER OUTLINE

1. Overview
2. Primary Data: Qualitative Versus Quantitative Research
3. A Classification of Qualitative Research Procedures
4. Focus Group Interviews
   i. Characteristics
   ii. Planning and Conducting Focus Groups
   iii. Advantages and Disadvantages of Focus Groups
   iv. Applications of Focus Groups
5. Online Focus Groups
   i. Advantages and Disadvantages of Online Focus Groups
6. Depth Interviews
   i. Conducting Depth Interviews
   ii. Advantages and Disadvantages of Depth Interviews
   iii. Applications of Depth Interviews
7. Projective Techniques
   i. Word Association
   ii. Sentence Completion
LEARNING TIPS

Focus on the issues identified in the following for each learning objective.

**Learning Objective 1**

* Differentiate between quantitative and qualitative research.

* Describe the interrelationship between qualitative research and quantitative research.

**Learning Objective 2**

* The three categories of qualitative research.

**Learning Objective 3**
* Definition of a focus group.

* The procedure for planning and conducting focus groups.

Use Figure 4.4 as a guideline to organize your learning.

* Advantages of focus groups.

* Disadvantages of focus groups.

**Learning Objective 4**

* Similarities and differences between focus groups and depth interviews.

* Advantages and disadvantages of depth interviews.

**Learning Objective 5**

* Indirect approach: Projective techniques.

* Forms of projective techniques.

* Figure 4.5 illustrates a cartoon test.

**Learning Objective 6**

* Problems with focus groups in international settings.

* Problems with depth interviews.

* Problems with projective techniques.

**Learning Objective 7**

* Discuss the role of social media in facilitating qualitative research: focus groups, depth interviews, and projective techniques.
Learning Objective 8

* Ethical questions pertaining to focus groups, depth interviews, and projective techniques.

TRUE/FALSE QUESTIONS

1. Qualitative research explores a problem with few preconceived notions about the outcome of that exploration.

2. Quantitative research is a research methodology that seeks to quantify the data and, typically, applies some form of statistical analysis.

3. According to the text, the typical duration of a focus group is one to three hours.

4. A focus group typically consists of six to eight participants.

5. Online focus groups take more time to set up and complete than traditional focus groups.

6. Focus groups are described as loosely structured conversations with individuals drawn from the target audience that require respondents to react to vague and ambiguous stimuli.

7. The stimulus avoidance technique is a classification of a projective technique used in marketing research.

8. The word association technique requires the respondent to complete an incomplete stimulus situation.

9. The picture response technique requires the respondent to construct a response to a picture in the form of a story, dialogue, or description.

10. In cultural settings such as in the Far East, where persons are hesitant to discuss their feelings in group situations, focus groups can still be used effectively compared to in-depth interviews.

MULTIPLE CHOICE QUESTIONS

1. In contrast to ____ research, the findings of ____ research cannot be treated as conclusive and used to recommend a final course of action.
   a. quantitative; qualitative
b. observational; qualitative
c. qualitative; quantitative
d. descriptive; observational
e. total; partial

2. Whenever a new marketing research problem is addressed, _____ research typically should follow appropriate _____ research.
a. qualitative; quantitative
b. quantitative; qualitative
c. observational; qualitative
d. descriptive; observational
e. total; partial

3. According to the text, the typical focus group costs the client about ____.
a. $1,000
b. $2,000
c. $3,000
d. $10,000
e. none of the above is correct

4. A disadvantage (or disadvantages) of focus groups include:
a. tendency to regard findings as conclusive
b. difficulty in moderating focus groups
c. completely skilled moderators are rare
d. coding, analysis, and interpretation are difficult
e. all of the above (a-d) are correct

5. An advantage (or advantages) of online focus groups include:
a. Geographic distance is overcome for respondents.
b. Client can observe from home or office.
c. Respondents can be re-contacted more easily.
d. People are less inhibited in their responses.
e. All of the above (a-d) are correct.

6. Which of the following is NOT a classification of the projective techniques used in marketing research?
a. word association
b. sentence completion
c. picture response technique
d. complete technique
e. third person technique

7. A projective technique in which respondents are presented with a list of words, one at a time is called ____.
a. sentence completion
b. story completion
c. role playing
d. piecewise thought-listing
e. none of the above is correct

8. Advantages of in-depth interviews over traditional focus groups include all of the following EXCEPT:
a. richer discussion of sensitive topics
b. deeper insights about underlying motives
c. less social pressure to conform
d. client involvement
e. scheduling of respondents

9. Which of the following is NOT an advantage of using depth interviews compared to using focus groups in marketing research?
a. Depth interviews can uncover deeper insights than focus groups.
b. Depth interviews result in a free exchange of information that may not be possible in focus groups.
c. Depth interviews attribute the responses directly to the respondent, unlike focus groups, where it is often difficult to determine which respondent made a particular response.
d. With probing, it is possible to get at the real issue when topics are complex.
e. All of the above (a-d) are advantages.

10. Which of the following describes the projective technique in which respondents are provided with part of a story and required to give the conclusion in their own words?
a. word association
b. story completion
c. role playing
d. evaluation technique
e. none of the above is correct

HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES

4-15. Follow the discussion in the text. An example outline is presented on the Chapter.

4-16. Use your imagination. Any appropriate cartoon that solicits an open ended response is applicable.

4-17. The Coca-Cola Company probably has a list of potential respondents who have expressed an interest in participating. Think about the screening criteria to use.
4-18. Think about how you would follow the depth interview procedure over the Internet in the text. Traditional depth interviews are discussed in the Chapter. Table 6.3 gives a comparison of traditional and online focus groups, which may be helpful.

4-20. Think about how you invite potential respondents. What type of screening criteria would you need? Invitations to potential respondents can be posted on the newsgroup site mentioned.

EXTRA MATERIALS

Focus Groups

<table>
<thead>
<tr>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Synergism</td>
<td>1. Misuse</td>
</tr>
<tr>
<td>2. Snowballing</td>
<td>2. Misjudge</td>
</tr>
<tr>
<td>5. Spontaneity</td>
<td>5. Misrepresentation</td>
</tr>
<tr>
<td>6. Serendipity</td>
<td></td>
</tr>
<tr>
<td>7. Specialization</td>
<td></td>
</tr>
<tr>
<td>8. Scientific scrutiny</td>
<td></td>
</tr>
<tr>
<td>9. Structure</td>
<td></td>
</tr>
<tr>
<td>10. Speed</td>
<td></td>
</tr>
</tbody>
</table>

Copyright © 2015 Pearson Education, Inc.
## Online Versus Traditional Focus Groups

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>Online Focus Groups</th>
<th>Traditional Focus Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group size</td>
<td>4 – 6</td>
<td>8 – 12</td>
</tr>
<tr>
<td>Group composition</td>
<td>Anywhere in the world</td>
<td>Drawn from the local area</td>
</tr>
<tr>
<td>Time duration</td>
<td>1 – 1.5 hours</td>
<td>1 – 3 hours</td>
</tr>
<tr>
<td>Physical setting</td>
<td>Researcher has little control</td>
<td>Under researcher's control</td>
</tr>
<tr>
<td>Respondent identity</td>
<td>Difficult to verify</td>
<td>Can be easily verified</td>
</tr>
<tr>
<td>Respondent attentiveness</td>
<td>Can engage in other tasks</td>
<td>Attentiveness monitored</td>
</tr>
<tr>
<td>Respondent recruiting</td>
<td>Easier. Flexible.</td>
<td>By traditional means</td>
</tr>
<tr>
<td>Group dynamics</td>
<td>Limited</td>
<td>Synergistic effect</td>
</tr>
<tr>
<td>Openness of respondents</td>
<td>Respondents more candid</td>
<td>Respondents candid, except for sensitive topics</td>
</tr>
</tbody>
</table>

## Online Versus Traditional Focus Groups (Cont.)

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>Online Focus Groups</th>
<th>Traditional Focus Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nonverbal communication</td>
<td>Body language not observed</td>
<td>Body language and emotions observed</td>
</tr>
<tr>
<td>Use of physical stimuli</td>
<td>Body language and emotions observed</td>
<td>Variety of stimuli can be used</td>
</tr>
<tr>
<td>Transcripts</td>
<td>Limited</td>
<td>Available immediately</td>
</tr>
<tr>
<td>Observers’ communication with moderator</td>
<td>Can communicate on a split-screen</td>
<td>Can manually send notes to the focus group room</td>
</tr>
<tr>
<td>Unique moderator skills</td>
<td>Typing, computer, familiar with chat room slang</td>
<td>Observational</td>
</tr>
<tr>
<td>Tumaround time</td>
<td>A few days</td>
<td>Many days</td>
</tr>
<tr>
<td>Client travel costs</td>
<td>None</td>
<td>Can be expensive</td>
</tr>
<tr>
<td>Basic focus group costs</td>
<td>Much less expensive</td>
<td>More expensive: facility, food, taping, and transcripts</td>
</tr>
</tbody>
</table>
### Focus Groups Versus Depth Interviews

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>Focus Groups</th>
<th>Depth Interviews</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group synergy and dynamics</td>
<td>+</td>
<td>-</td>
</tr>
<tr>
<td>Peer pressure/group influence</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>Client involvement</td>
<td>+</td>
<td>-</td>
</tr>
<tr>
<td>Generation of innovative ideas</td>
<td>+</td>
<td>-</td>
</tr>
<tr>
<td>In-depth probing of individuals</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>Uncovering hidden motives</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>Discussion of sensitive topics</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>Interviewing respondents who are</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>competitors</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interviewing respondents who are</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>professionals</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scheduling of respondents</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>Amount of information</td>
<td>+</td>
<td>-</td>
</tr>
<tr>
<td>Bias in moderation and interpretation</td>
<td>+</td>
<td>-</td>
</tr>
<tr>
<td>Cost per respondent</td>
<td>+</td>
<td>-</td>
</tr>
</tbody>
</table>

Note: A “+” indicates a relative advantage over the other procedure. A “−” indicates a relative disadvantage.

---

**Figure 4.6 A Concept Map for Qualitative Research**

- **Marketing Research Data**
  - **Secondary** may be **Primary**
  - **Qualitative** may be **Quantitative**
    - direct procedures
    - indirect procedures
  - **Focus Groups** may be **In-depth Interviews**
  - **Projective Techniques** consist of
    - Word Association
    - Sentence Completion
    - Picture Response Cartoon Test
    - Role Playing Third-Person Technique
CHAPTER 5
SURVEY AND OBSERVATION

LEARNING OBJECTIVES

1. Discuss and classify survey methods available to marketing researchers, and describe the various telephone, personal, mail, and electronic interviewing methods.
2. Compare the different methods, and evaluate which is best suited for a particular research project.
3. Explain how survey response rates can be improved.
4. Explain and classify the different observation methods used by marketing researchers and describe personal observation and mechanical observation.
5. Describe the relative advantages and disadvantages of observational methods and compare them to survey methods.
6. Discuss the considerations involved in implementing surveys and observation methods in an international setting.
7. Explain how social media can be used to implement survey and observation methods.
8. Understand the ethical issues involved in conducting survey and observation research.

CHAPTER OUTLINE

1. Overview
2. Survey Methods
3. Survey Methods Classified by Mode of Administration
4. Telephone Methods
   i. Traditional Telephone Interviews
   ii. Computer-Assisted Telephone Interviewing (CATI)
   iii. Advantages and Disadvantages of Telephone Interviewing
5. Personal Methods
   i. Personal In-Home Interviews
      a. Advantages and Disadvantages of Personal In-Home Interviews
   ii. Mall Intercept Personal Interviews
      a. Advantages and Disadvantages of Mall Intercept Interviews
   iii. Computer Assisted Personal Interviewing (CAPI)
      a. Advantages and Disadvantages of CAPI
6. Mail Methods
   i. Mail Interviews
   ii. Mail Panels
   iii. Advantages and Disadvantages of Mail Surveys
7. Electronic Methods
LEARNING TIPS

Focus on the issues identified in the following for each learning objective.

**Learning Objective 1**

* Classification of different survey methods by mode of administration.

*Figure 5.4 can be used to expand the discussion on some of these topics.*

**Learning Objective 2**

* A comparative evaluation of different survey methods.
Table 5.1 can be used here as framework for evaluating survey methods.

**Learning Objective 3**
* How the survey response rates can be improved.

**Learning Objective 4**
* A classification of the observational methods by mode of administration.

**Learning Objective 5**
* Relative advantages and disadvantages of observation methods versus survey methods.

* Table 5.3 can serve as a guideline for discussion.

**Learning Objective 6**
* Difficulties in implementing survey and observation methods internationally.
* The criteria for selection of a survey method.

**Learning Objective 7**
* How social media is changing survey administration.
* How social media is impacting observation methods.

**Learning Objective 8**
* The ethical responsibility of confidentiality.
TRUE/FALSE QUESTIONS

1. Observation is survey information obtained by questioning respondents.

2. The method of interview that is the most popular for collecting survey data is telephone interviewing.

3. The percentage of the total attempted interviews that are completed is referred to as survey completion rate.

4. In-home interviewing has a potential problem of interviewer supervision and control.

5. An advantage of using in-home interviewing to collect research data is very good sample control.

6. Using mail interviews to collect research data does not allow the ability to control the interviewing environment.

7. The tendency of the respondents to give answers that may be accurate but that may not be desirable from a social standpoint is called social desirability.

8. Non-response bias is the bias that arises when actual respondents differ from those who refuse to participate in ways that affect the survey results.

9. An observational research strategy in which human observers record the phenomenon being observed is called mechanical observation.

10. "Optical character-recognition" at supermarket check-outs is a form of mechanical observation.

MULTIPLE CHOICE QUESTIONS

1. According to the text, which of the following types of questions do lend themselves to survey research?
   a. questions regarding behavior
   b. questions regarding attitudes
   c. questions regarding lifestyle characteristics
   d. questions regarding motivations
   e. all of the above are correct

Copyright © 2015 Pearson Education, Inc.
2. All of the following are recognized as disadvantages of using telephone interviewing to collect research data EXCEPT:
   a. no use of physical stimuli
   b. limited to simple questions
   c. low quantity of data
   d. no interviewer bias
   e. b and c above are correct

3. Which of the following is NOT an advantage of using computer-assisted personal interviewing to collect research data?
   a. good response rate
   b. low social desirability
   c. low potential for interviewer bias
   d. good for physical stimuli
   e. very good control of environment

4. Which of the following is NOT recognized as an advantage of using mail interviews to collect research data?
   a. no interviewer bias
   b. good sample control
   c. low social desirability
   d. low/moderate cost
   e. a and b above

5. All of the following are recognized as disadvantages of using e-mail interviewing to collect research data EXCEPT:
   a. lack of visual appeal
   b. low sample control
   c. low response rate
   d. moderate quantity of data
   e. all of the above (a-d)

6. According to the text, which of the following is an advantage of mall intercepts?
   a. potential for interviewer bias
   b. high cost
   c. very good response rate
   d. moderate quantity of data
   e. high social desirability

7. According to the text, which of the following is not a disadvantage of mall intercepts?
   a. potential for interviewer bias
   b. high cost
   c. low response rate
   d. moderate quantity of data
e. high social desirability

8. Which of the following is NOT mentioned in the text as a method used to improve response rates?
   a. prior notification
   b. incentives
   c. follow-up
   d. use of larger samples
   e. All of these methods are used to improve response rates.

9. Which of the survey methods listed below would not be appropriate when using physical stimuli?
   a. in-home
   b. mall intercept
   c. CAPI
   d. telephone
   e. none of the above are suitable

10. Telephone interviewing is a popular mode of administering questionnaires in ______.
    a. U.S.
    b. Canada
    c. India
    d. a and b above only
    e. a, b, and c above

HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES

5-8. Give some thought to identifying a situation in which both the survey and observation methods would be appropriate. Perhaps identify a situation where both consumer behavior to stimuli and their underlying feelings toward the stimuli would yield pertinent information.

5-9. Consider observation, survey and secondary information. If using a survey, how may that be done? If using an observation study, how may that be done? What types of secondary information may be helpful?

5-10. Consider the evaluation criteria in the text.

5-11. Consider the evaluation criteria in the text. Table 5.1 and the criteria for selecting a survey method in Chapter 5 will be helpful.
5-12. Since the sample size is small, summarize your results in a qualitative and not quantitative manner.
CHAPTER 6

EXPERIMENTATION

LEARNING OBJECTIVES

1. Explain the concept of causality as defined in marketing research and distinguish between
   the ordinary meaning and the scientific meaning of causality.
2. Discuss the conditions for causality, and whether a causal relationship can be
   demonstrated conclusively.
3. Define and differentiate the two types of validity: internal validity and external validity.
4. Describe and evaluate experimental designs and the differences among pre-experimental,
   true experimental, and statistical designs.
5. Compare and contrast the use of laboratory versus field experimentation and
   experimental versus non-experimental designs in marketing research.
6. Understand why the internal and external validity of field experiments conducted
   overseas is generally lower than in the United States.
7. Describe how social media facilitate causal research.
8. Describe the ethical issues involved in conducting causal research and the role of
   debriefing in addressing some of these issues.

CHAPTER OUTLINE

1. Overview
2. Concept of Causality
3. Conditions for Causality
   i. Concomitant Variation
   ii. Time Order of Occurrence of Variables
   iii. Absence of Other Possible Causal Factors
   iv. Role of Evidence
4. What is Experimentation?
5. Definition and Concepts
6. Definition of Symbols
7. Validity in Experimentation
   i. Internal Validity
   ii. External Validity
8. Controlling Extraneous Variables
9. A Classification of Experimental Designs
10. Pre-experimental Designs
    i. One-Shot Case Study
LEARNING TIPS

Focus on the issues identified in the following for each learning objective.

**Learning Objective 1**

* The concept of causality as used in marketing.
* Key definitions related to experimentation.

**Learning Objective 2**

* Three necessary conditions to infer causality.

**Learning Objective 3**
* Difference between internal and external validity.

**Learning Objective 4**

* Differences in the types of experimental designs.

* Pre-experimental designs and their shortcomings.

* Significant features of a true experimental design.

* The nature and uses of statistical designs.

For an example of a factorial design, see Table 6.1

**Learning Objective 5**

* Whether laboratory or field experiments are more useful in marketing research.

* Limitations of experimentation.

**Learning Objective 6**

* Difficulties involved with international experiments.

**Learning Objective 7**

* How social media is facilitating experimentation.

**Learning Objective 8**

* Ethical responsibilities resulting from disguised experiments.
TRUE/FALSE QUESTIONS

1. Variables that measure the effect of the independent variables on the test units are called testing variables.

2. Consumers are good examples of independent variables.

3. According to the text, an experimental group is the group exposed to the manipulated independent variable.

4. Internal validity refers to whether the manipulation of the independent variables or treatments actually caused the observed effects on the dependent variables.

5. External validity refers to whether the cause-and-effect relationships found in the experiment remain the same when replicated in a larger population.

6. Pre-experimental designs do not employ randomization.

7. Pre-experimental designs allow for the statistical control and analysis of external variables.

8. Statistical designs include the pretest-posttest control group design and the posttest-only control group design.

9. According to the text, factorial designs are commonly used statistical designs.

10. The internal and external validity of field experiments conducted overseas is generally higher than in the U.S.

MULTIPLE CHOICE QUESTIONS

1. _____ takes place when the occurrence of X increases the probability of the occurrence of Y.
   a. Probability
   b. Reliability
   c. Validity
   d. True scores
   e. None of the above is correct

2. According to the text, experiments can be described in terms of all of the following EXCEPT:
   a. independent variables
   b. concomitant variables
   c. dependent variables
d. extraneous variables

3. ____ variables are variables that are manipulated by the researcher and whose effects are measured and compared.
   a. Dependent
   b. Interdependent
   c. Extraneous
   d. Test unit
   e. None of the above is correct

4. All of the following are good examples of independent variables EXCEPT:
   a. price levels
   b. package designs
   c. advertising themes
   d. frequency of purchase by consumers
   e. c and d both

5. All of the following are good examples of test units EXCEPT:
   a. consumers
   b. level of promotion
   c. stores
   d. geographic areas
   e. b and d both

6. All of the following are good examples of dependent variables EXCEPT:
   a. price levels
   b. sales
   c. attitude toward the brand
   d. frequency of purchase by consumers
   e. c and d both

7. Which of the following is NOT a way of controlling extraneous variables?
   a. randomization
   b. statistical control
   c. client control
   d. researcher control
   e. both c and d

8. Which of the following is NOT one of the broad categories of experimental designs?
   a. post-experimental design
   b. pre-experimental design
   c. statistical design
   d. true experimental
9. Which of the following is NOT one of the three types of pre-experimental designs?
   a. the one-shot case study
   b. the one-group pretest-posttest design
   c. optimal design
   d. the static group
   e. c and d both

10. Field experiments feature which of the following?
    a. Realistic environment
    b. High control
    c. Low external validity
    d. a and c are correct
    e. a, b, and c are correct

HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES

6-11 to 6-19. Review the discussions on what is experimentation and a classification of experimental designs in the text.

EXTRA MATERIALS
CHAPTER 7

MEASUREMENT AND SCALING

LEARNING OBJECTIVES

1. Introduce the concepts of measurement and scaling and show how scaling may be considered an extension of measurement.
2. Discuss the primary scales of measurement and differentiate nominal, ordinal, interval, and ratio scales.
3. Classify scaling techniques as comparative and noncomparative, and describe the comparative techniques of paired comparison, rank order, and constant sum.
4. Describe the noncomparative scaling techniques, distinguish between continuous and itemized rating scales, and explain Likert, semantic differential, and Stapel scales.
5. Discuss the variations involved in constructing itemized rating scales.
6. Discuss the criteria used for scale evaluation and explain how to assess reliability and validity.
7. Discuss the considerations involved in implementing scales of measurement in an international setting.
8. Explain how social media can be used to implement comparative and noncomparative scaling techniques.
9. Understand the ethical issues involved in selecting scales of measurement.

CHAPTER OUTLINE

1. Overview
2. Measurement and Scaling
3. Primary Scales of Measurement
   i. Nominal Scale
   ii. Ordinal Scale
   iii. Interval Scale
   iv. Ratio Scale
4. Comparative and Noncomparative Scaling Techniques
5. Comparative Scaling Techniques
   i. Paired Comparison Scaling
   ii. Rank Order Scaling
   iii. Constant Sum Scaling
6. Noncomparative Scaling Techniques
   i. Continuous Rating Scale
7. Itemized Rating Scales
LEARNING TIPS

Focus on the issues identified in the following for each learning objective.

**Learning Objective 1**

* The differences between measurement and scaling.

**Learning Objective 2**

* The primary scales of measurement.

* Figures 7.2 and 7.3 and Tables 7.1 and 7.2 provide a framework and examples for explaining the primary scales.

**Learning Objective 3**

* The two broad scaling measures.

* See Figures 7.4 and 7.5 for the classification of scaling procedures.
* The different comparative scaling techniques.

Learning Objective 4

* The different noncomparative scaling techniques.

* Various types of itemized rating scales.

Learning Objective 5

* Major decisions involved in constructing itemized rating scales.

Learning Objective 6

* The criteria used to evaluate a multi-item scale.

> Figure 7.7 can be used to discuss the issues involved in scale evaluation.

Learning Objective 7

* Measurement and scaling issues in International research.

* Other international concerns.

Learning Objective 8

* Social media can be used to implement the primary type of scales.

* Role of social media in facilitating noncomparative scaling.

Learning Objective 9

* The ethical concerns of scaling.
* The ethical implications of misusing scale descriptors.

* Other areas of ethical concern.

**TRUE/FALSE QUESTIONS**

1. The assignment of numbers or other symbols to characteristics of objects according to certain prespecified rules is called scaling.

2. A scale whose numbers serve only as labels or tags for identifying and classifying objects with a strict one-to-one correspondence between the numbers and the objects is called a nominal scale.

3. Ordinal scales are recognized as the most basic or limited.

4. The numbers assigned in a nominal scale reflect relative amounts of the characteristic being measured.

5. A ranking scale in which numbers are assigned to objects to indicate the relative extent to which some characteristic is possessed is called a ratio scale.

6. According to the text, noncomparative scales are broadly classified as either continuous or itemized.

7. According to the text, a Likert scale is one of the commonly used itemized rating scales.

8. A Stapel scale is described as a seven-point rating scale with end points associated with bipolar labels that have semantic meaning.

9. When using a Likert scale, the respondent is typically asked to rate a brand, store, or some other object in terms of bipolar adjectives, such as cold and warm.

10. A scale for measuring attitudes that consists of a single adjective in the middle of an even-numbered range of values is called a semantic differential scale.

**MULTIPLE CHOICE QUESTIONS**

1. Which of the following is one of the four primary scales of measurement?
   a. nominal scales
   b. ordinal scales
   c. interval scales
   d. ratio scales
2. Among the primary scales of measurement, the ________ has an absolute zero.
   a. ordinal scale
   b. interval scale
   c. ratio scale
   d. nominal scale
   e. random scale

3. Assigning a "1" to all males and a "2" to all females is an example of which of the following primary scales of measurement?
   a. ordinal scales
   b. ratio scales
   c. nominal scales
   d. interval scales
   e. random scales

4. Assigning a "1" to all males and a "2" to all females is an example of:
   a. mutually exclusive
   b. collectively exclusive
   c. mutually exhaustive
   d. collectively exhaustive
   e. a and d

5. A(n) ________ is a scale in which the numbers are used to rate objects such that numerically equal distances on the scale represent equal distances in the characteristic being measured.
   a. nominal scale
   b. ordinal scale
   c. optimal scale
   d. random scale
   e. none of the above is correct

6. A(n) ________ is the highest level of measurement and allows the researcher to identify or classify objects, rank order the objects, and compare intervals or differences.
   a. random scale
   b. nominal scale
   c. ordinal scale
   d. interval scale
   e. none of the above is correct

7. "How would you rate Dial bath soap? The cursor may be placed at any point." This is an example of which of the following?
   a. a comparative scale
   b. a continuous rating scale
c. an itemized rating scale  
d. a Likert scale  
e. extreme scaling

8. A measurement scale with five response categories ranging from "strongly disagree" to "strongly agree," which requires the respondents to indicate a degree of agreement or disagreement with each of a series of statements related to the stimulus object is called a(n) ____________.
   a. Continuous rating scale  
b. semantic differential  
c. Stapel scale  
d. Likert scale  
e. none of the above

9. Which of the following types of scales is described as a seven-point rating scale with end points associated with bipolar labels that have semantic meaning?
   a. Likert scale  
b. Stapel scale  
c. balanced rating scale  
d. semantic differential scales  
e. none of the above

10. A scale for measuring attitudes that consists of a single adjective in the middle of an even-numbered range of values is called a ____________.
   a. Likert scale  
b. semantic differential  
c. balanced rating scale  
d. mid-range scale  
e. none of the above

HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES

7-20. Review the section on Primary Scales in the text.

7-21. Review the section on Itemized Rating Scales in the text.

7-22. Make sure that you have a multi-item scale with anchors that are both understandable and relevant. The scale should contain 5 to 9 values and be uniform throughout the items. Reverse scoring should be used. For assessing reliability and validity see the section on Scale Evaluation.

7-23. Review the section on Itemized Rating Scales in the text.
7-24. Review the section on Itemized Rating Scales in the text.

7-25. Review the section on Primary Scales in the text.

7-26. Review the section on Primary Scales in the text.

7-27. Think about how consumers would use the Internet to develop your questions. The Likert scale example in Applied Problem 1 can be used as a guide to development of your scale.

7-28. Think about how consumers would use the Ford Web site to develop your questions. The Likert scale example in Applied Problem 1 can be used as a guide to development of your scale.

7-29. Think about how consumers would compare FedEx to UPS overnight delivery service. You will need a series of bi-polar adjectives such as reliable – unreliable. The semantic differential scale example in Applied Problem 1 can be used as a guide to development of your scale.

7-30. Use the section on Noncomparative Itemized Rating Scale Decisions as your guide.

7-31. Make sure that you relate the scales to the marketing research context (problem) and the managerial context (management decision problem).

EXTRA MATERIALS
An Illustration of Paired Comparison Scaling

Instructions
We are going to present you with ten pairs of shampoo brands. For each pair, please indicate which one of the two brands of shampoo in the pair you would prefer for personal use.

Recording Form

<table>
<thead>
<tr>
<th></th>
<th>Jhirmack</th>
<th>Finesse</th>
<th>Vidal Sassoon</th>
<th>Head &amp; Shoulders</th>
<th>Pert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jhirmack</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Finesse</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Vidal Sassoon</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Head &amp; Shoulders</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pert</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Number of times preferred</td>
<td>3*</td>
<td>2</td>
<td>0</td>
<td>4</td>
<td>1</td>
</tr>
</tbody>
</table>

* A 1 in a particular box means that the brand in that column was preferred over the brand in the corresponding row. A 0 means that the row brand was preferred over the column brand.
* The number of times a brand was preferred is obtained by summing the 1s in each column.

An Illustration of Rank Order Scaling

Instructions
Rank the various brands of toothpaste in order of preference. Begin by picking out the one brand that you like most and assign it a number 1. Then find the second most preferred brand and assign it a number 2. Continue this procedure until you have ranked all the brands of toothpaste in order of preference. The least preferred brand should be assigned a rank of 10. No two brands should receive the same rank number. The criteria of preference is entirely up to you. There is no right or wrong answer—just try to be consistent.
An Illustration of Constant Sum Scaling

Instructions
Below are eight attributes of bathing soaps. Please allocate 100 points among the attributes so that your allocation reflects the relative importance you attach to each attribute. The more points an attribute receives, the more important the attribute is. If an attribute is not at all important, assign it zero points. If an attribute is twice as important as some other attribute, it should receive twice as many points.

Form

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Segment I</th>
<th>Segment II</th>
<th>Segment III</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Mildness</td>
<td>8</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>2. Lather</td>
<td>2</td>
<td>4</td>
<td>17</td>
</tr>
<tr>
<td>3. Shrinkage</td>
<td>3</td>
<td>9</td>
<td>7</td>
</tr>
<tr>
<td>4. Price</td>
<td>63</td>
<td>17</td>
<td>9</td>
</tr>
<tr>
<td>5. Fragrance</td>
<td>9</td>
<td>0</td>
<td>19</td>
</tr>
<tr>
<td>6. Packaging</td>
<td>7</td>
<td>5</td>
<td>9</td>
</tr>
<tr>
<td>7. Moisturizing</td>
<td>5</td>
<td>3</td>
<td>20</td>
</tr>
<tr>
<td>8. Cleaning Power</td>
<td>13</td>
<td>60</td>
<td>15</td>
</tr>
<tr>
<td>SUM</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

Relationship of Measurement and Scaling to the Marketing Research Process

Step 1: Marketing Research Problem Definition

Step 2: Approach to the Problem
• Specification of information needed

Step 3: Research Design
• Appropriate level of measurement and appropriate scales to measure each item of information
• Questionnaire Design: translation of the information needed to appropriate questions using the identified scales

Step 6: Data Preparation and Analysis:
• Using appropriate statistical techniques compatible with the level of measurement of the data
CHAPTER 8

QUESTIONNAIRE AND FORM DESIGN

LEARNING OBJECTIVES

1. Explain the purpose of a questionnaire and its objectives.
2. Describe the process of designing a questionnaire, the steps involved, and guidelines that must be followed at each step.
3. Discuss the observational form of data collection.
4. Discuss the use of software for designing questionnaires.
5. Explain the considerations involved in designing questionnaires for international marketing research.
6. Explain how social media interface with questionnaire design.
7. Understand the ethical issues involved in questionnaire design.

CHAPTER OUTLINE

1. Overview
2. Importance of Questionnaire
   i. Questionnaire Definition
3. Questionnaire Design Process
4. Specify the Information Needed
5. Specify Type of Interviewing Method
6. Determine the Content of Individual Questions
   i. Is the Question Necessary?
   ii. Are Several Questions Needed Instead of One?
7. Design the Question to Overcome the Respondent’s Inability to Answer
   i. Can the Respondent Remember?
   ii. Can the Respondent Articulate?
8. Design the Questionnaire to Overcome the Respondent’s Unwillingness to Answer
   i. Effort Required of the Respondents
   ii. Sensitive Information
9. Decide on the Question Structure
   i. Unstructured Questions
   ii. Structured Questions
10. Determine the Question Wording
    i. Define the Issue
    ii. Use Simple Words
    iii. Use Unambiguous Words
iv. Avoid Producing Leading or Biasing Questions  
v. Balance Dual Statements  

11. Arrange the Questions in Proper Order  
i. Opening Questions  
ii. Type of Information  
iii. Difficult Questions  
iv. Effect on Subsequent Questions  
v. Logical Order  

12. Choose the Form and Layout  
13. Reproduction of the Questionnaire  
14. Pretest the Questionnaire  
15. Observational Forms  
16. International Marketing Research  
17. Marketing Research and Social Media  
18. Ethics in Marketing Research  
19. Summary  
20. Key Terms and Concepts  
21. Acronyms  

**LEARNING TIPS**

Focus on the issues identified in the following for each learning objective.

**Learning Objective 1**

* The importance of a well-constructed data collection instrument.  

* The three major objectives of a questionnaire.  

**Learning Objective 2**

* The steps involved in the questionnaire design process.  

*Figure 8.2 offers a means of structuring the discussion on questionnaire design.*

**Learning Objective 3**
Learning Objective 4

* Discuss the use of software for designing questionnaires.

Learning Objective 5

* Cultural influences on questionnaire design.
  * The pros and cons of structured and unstructured questionnaires.

Learning Objective 6

* The role of social media in questionnaire design.

Learning Objective 7

* The ethical responsibilities researchers have to the respondents.
  * Discuss the ethical responsibilities researchers have to clients.

TRUE/FALSE QUESTIONS

1. According to the text, a conversational style should be used when writing interviewer-administered questionnaires.

2. The last step in the questionnaire design process is to eliminate bugs in the questionnaire by pretesting.

3. A single question that attempts to cover two issues is called a leading question.

4. To increase the likelihood of obtaining sensitive information, such topics should be placed at the end of the questionnaire.

5. Open-ended questions that respondents answer in their own words are called structured questions.
6. A respondent's tendency to choose an alternative merely because it occupies a certain position on the page or in a list is called leader bias.

7. "Usually," "normally," and "frequently" are examples of words that are oftentimes considered ambiguous to respondents.

8. Socioeconomic and demographic characteristics used to categorize respondents are referred to as identification information.

9. Sensitive information should appear at the beginning of the questionnaire.

10. According to the text, initial pretests are best done by personal interviews.

MULTIPLE CHOICE QUESTIONS

1. All of the following are mentioned in the text as specific objectives of a questionnaire EXCEPT:
   a. Translate the researcher's information needs into a set of specific questions that respondents are willing and able to answer.
   b. Minimize demands imposed on respondents.
   c. Minimize response error.
   d. Assign numerical values to responses.
   e. All of the above are correct.

2. Which of the following is the first step in the questionnaire design process?
   a. specify the type of interviewing method
   b. determine the content of individual questions
   c. decide on the question structure
   d. segment the customer base
   e. none of the above is correct

3. Which of the following is a popular form of structured questions?
   a. multiple-choice
   b. dichotomous
   c. open-ended
   d. scales
   e. a, b and d above are correct

4. A(n) ________ is a structured question with only two response alternatives, such as yes or no.
   a. open-ended question
   b. multiple-choice question
c. random question  
d. yay-nay questions  
e. none of the above is correct

5. All of the following are mentioned in the text as specific guidelines to follow to avoid problems in question wording EXCEPT:
   a. use ordinary words  
b. avoid ambiguous words  
c. avoid leading questions  
d. don't use positive and negative statements  
e. c and d above

6. Which of the following of the 6 W's is NOT particularly well-suited for serving as a guideline for defining the issue in a question?
   a. who  
b. what  
c. when  
d. where  
e. which

7. All of the following are examples of words that are often considered confusing to respondents EXCEPT:
   a. usually  
b. normally  
c. frequently  
d. sometimes  
e. all of the above are considered confusing

8. Socioeconomic and demographic characteristics used to categorize respondents are referred to as _________.
   a. basic information  
b. problem-solving information  
c. identification information  
d. quantification information  
e. none of the above is correct

9. In questionnaire design, assigning a code to every conceivable response before data collection is called _________.
   a. filtering  
b. branching  
c. skipping  
d. funneling  
e. none of the above is correct

Copyright © 2015 Pearson Education, Inc.
10. According to the text, pretesting of the questionnaire ideally should be done with ___ potential respondents.
   a. 1 - 14
   b. 15 - 30
   c. 31 – 50
   d. 51 – 75
   e. none of the above

**HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES**

8-16. Double-barreled questions are discussed in the subsection entitled Are Several Questions Needed Instead of One?

8-17. An example of an ambiguous word is “usually”.

8-18. For these, think of who, what, where, and when aspects of the issue.

8-19. These three types of question formats are discussed in the section entitled Decide on the Question Structure.

8-20. To answer this question, you will need to review the entire chapter. Use the guidelines given in Table 8.1.

8-21. Think of such things as familiarity and usage of personal computers, familiarity with the four computer firms, usage of the internet, image attributes and respondent demographics.

8-22. In addition to Qualtrics, there are a number of other questionnaire design and online survey sites mentioned in Chapter 8.

8-24. Evaluate the questionnaire using the guidelines given in Table 8.1.

**EXTRA MATERIALS**
### Effect of Interviewing Method on Questionnaire Design

#### Department Store Project

**Mail, E-mail, or Internet Questionnaire**

Please rank order the following department stores in order of your preference to shop at these stores. Begin by picking out the one store that you like most and assign it a number 1. Then find the second most preferred department store and assign it a number 2. Continue this procedure until you have ranked all the stores in order of preference. The least preferred store should be assigned a rank of 10. No two stores should receive the same rank number.

<table>
<thead>
<tr>
<th>Store</th>
<th>Rank Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Lord &amp; Taylor</td>
<td></td>
</tr>
<tr>
<td>2. Macy's</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>10. Wal-Mart</td>
<td></td>
</tr>
</tbody>
</table>

Copyright © 2015 Pearson Education, Inc.
Effect of Interviewing Method on Questionnaire Design (Cont.)

Personal Questionnaire

(HANDLE DEPARTMENT STORE CARDS TO THE RESPONDENT.) Here is a set of department store names, each written on a separate card. Please examine these cards carefully. (GIVE RESPONDENT TIME). Now, please examine these cards again and pull out that card which has the name of the store you like the most i.e., your most preferred store for shopping. (RECORD THE STORE NAME AND KEEP THIS CARD WITH YOU). Now, please examine the remaining nine cards. Of these remaining nine stores, what is your most preferred store for shopping? (REPEAT THIS PROCEDURE SEQUENTIALLY UNTIL THE RESPONDENT HAS ONLY ONE CARD LEFT.)

<table>
<thead>
<tr>
<th>Store Rank</th>
<th>Name of Store</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>·</td>
<td>·</td>
</tr>
<tr>
<td>·</td>
<td>·</td>
</tr>
<tr>
<td>10.</td>
<td>10</td>
</tr>
</tbody>
</table>

Overcoming Inability to Answer

Overcoming Inability to Answer

- Is the Respondent Informed?
  - Use Filter Questions that Measure Familiarity
- Can the Respondent Remember?
  - Use the Aided Recall Approach
- Can the Respondent Articulate?
  - Give Aids: Pictures and Descriptions
Overcoming Unwillingness to Answer

Effort required of respondents

Information may be sensitive

Provide response options

Use desensitizing techniques

Advantages and Disadvantages of Unstructured and Structured Questions

<table>
<thead>
<tr>
<th>Question Type</th>
<th>Advantages</th>
<th>Disadvantages</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unstructured</td>
<td>Good as first questions, Responses are less biased, Can provide rich insights</td>
<td>Potential for interviewer bias, Coding is costly and time consuming, Greater weight to articulate respondents, Unsuitable for self-administered questionnaires</td>
<td>Useful for exploratory research</td>
</tr>
<tr>
<td>Multiple-Choice</td>
<td>Interviewer bias is reduced, Easy to code and analyze, Improved respondent co-operation</td>
<td>Order or position bias, Difficult to design response options</td>
<td>Responses should be mutually exclusive and collectively exhaustive, Useful in large surveys</td>
</tr>
</tbody>
</table>
Advantages and Disadvantages of Unstructured and Structured Questions

<table>
<thead>
<tr>
<th>Question Type</th>
<th>Advantages</th>
<th>Disadvantages</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dichotomous</td>
<td>Same as multiple-choice</td>
<td>Wording can bias the responses</td>
<td>Use split ballot technique</td>
</tr>
<tr>
<td>Scales</td>
<td>Same as multiple-choice</td>
<td>Difficult to design multi-item scales</td>
<td>Scales should be evaluated for reliability and validity</td>
</tr>
</tbody>
</table>

**Figure 8.7 A Concept Map for Question Wording**

1. **Define the issue**
3. **Use ordinary words**
4. **Words Should Match the Vocabulary Level of Respondents**
5. **Use unambiguous words**
6. **Avoid Usually, Normally, Regularly, Frequently, Sometimes, etc.**
7. **Avoid leading or biasing the respondent**
8. **Do Not Bias or Clue the respondent to What the Answer Should be**
9. **Use dual statements**
10. **Statements Should be Positive and Negative**

Copyright © 2015 Pearson Education, Inc.
CHAPTER 9

SAMPLING: DESIGN AND PROCEDURES

LEARNING OBJECTIVES

1. Differentiate a sample from a census and identify the conditions which favor the use of a sample versus a census.
2. Discuss the sampling design process: definition of the target population, determination of the sampling frame, selection of sampling technique(s), determination of sample size, and execution of the sampling process.
3. Classify sampling techniques as nonprobability and probability sampling techniques.
4. Describe the nonprobability sampling techniques of convenience, judgmental, quota, and snowball sampling.
5. Describe the probability sampling techniques of simple random, systematic, stratified, and cluster sampling.
6. Identify the conditions which favor the use of nonprobability sampling versus probability sampling.
7. Understand the sampling design process and the use of sampling techniques in international marketing research.
8. Describe how the representativeness of social media samples can be improved.
9. Identify the ethical issues related to the sampling design process and the use of appropriate sampling techniques.
10. Explain the use of the Internet and computers in sampling design.

CHAPTER OUTLINE

1. Overview
2. Sample or Census
3. The Sampling Design Process
   i. Define the target population
   ii. Determine the Sampling Frame
   iii. Select a Sampling Technique
   iv. Determine the Sample Size
   v. Execute the Sampling Process
4. A Classification of Sampling Techniques
5. Nonprobability Sampling Techniques
   i. Convenience Sampling
   ii. Judgmental Sampling
   iii. Quota Sampling
iv. Snowball Sampling

6. Probability Sampling Techniques
   i. Simple Random Sampling (SRS)
   ii. Systematic Sampling
   iii. Stratified Sampling
   iv. Cluster Sampling

7. Choosing Nonprobability versus Probability Sampling

8. International Marketing Research

9. Social Media and Marketing Research

10. Ethics in Marketing Research

11. Internet Sampling

12. Summary

13. Key Terms and Concepts

14. Acronyms

**LEARNING TIPS**

Focus on the issues identified in the following for each learning objective.

**Learning Objective 1**

* How sampling is used to achieve the objectives of marketing research.

* Definition of a population, a census, and a sample.

**Learning Objective 2**

* The relationship between the sample design process and the research project.

* The sampling design process.

**Learning Objective 3**

* Differences between probability and nonprobability sampling techniques.

Refer to Figure 9.5 and 9.6 to outline probability and nonprobability sampling techniques.
Learning Objective 4

* Various nonprobability sampling techniques.
* The advantages and disadvantages of each nonprobability sampling technique.

Learning Objective 5

* Various probability sampling techniques.
* Discuss the advantages and disadvantages of each probability sampling technique.

Learning Objective 6

* The choice between nonprobability and probability samples.

Learning Objective 7

* Difficulties in international marketing research.

Learning Objective 8

* How social media can facilitate and enhance sampling.

Learning Objective 9

* The researcher’s responsibilities to the client and respondents.

Learning Objective 10

* The issues in online sampling.
TRUE/FALSE QUESTIONS

1. In sampling, an element is the object or person about which or from which the information is desired.

2. According to the text, in survey research, the element is usually the respondent.

3. According to the text, the first step in the sampling design process is to define the target population.

4. A sampling frame is a representation of the elements of the target population, which consists of a list, or set of directions for identifying the sample size.

5. Sampling techniques that use chance selection procedures and rely on the personal judgment of the researcher are called nonprobability sampling techniques.

6. An example of nonprobability sampling is judgmental sampling.

7. The typical range for sample size in problem solving research, product tests, and test marketing studies is 1500-1600 respondents.

8. Cluster sampling is an example of probability sampling technique.

9. A form of convenience sampling in which the population elements are selected based on the researcher's discretion is called systematic sampling.

10. Area sampling is a form of stratified sampling based on geographic areas such as counties, housing tracts, or blocks.

MULTIPLE CHOICE QUESTIONS

1. Which of the following is NOT one of the five basic questions that are addressed in the sample design phase?
   a. "Should a sample be taken?"
   b. "What kind of sample should be taken?"
   c. "How large should the sample be?"
   d. "What process should be followed?"
   e. All of the above are among the five basic questions.

2. According to the text, in survey research, the element is usually the _________.
   a. questionnaire
   b. interviewer
c. product
d. Metropolitan Statistical Area (MSA)
e. none of the above is correct

3. A complete enumeration of the elements of a population or study objects is called a(n) _________.
   a. sample
   b. element
   c. sampling unit
   d. count
   e. none of the above is correct

4. Which of the following conditions favor the choice of using a sample over a census?
   a. small budget
   b. time available is short
   c. population size is large
   d. variance in the characteristic of interest is low
   e. all of the above are correct

5. The target population should be defined in terms of all of the following EXCEPT:
   a. elements
   b. distance
   c. sampling units
   d. time frame
   e. extent

6. A telephone directory does not include cell phone numbers. This would constitute a ________ error if used for sample selection.
   a. population
   b. sampling frame
   c. sample size
   d. census
   e. none of the above is correct

7. Sampling techniques that use chance selection procedures are called _________.
   a. probability sampling techniques
   b. nonprobability sampling techniques
   c. convenience sampling
   d. quota sampling
   e. semantic differential sampling

8. All of the following are examples of commonly used nonprobability sampling techniques EXCEPT:
   a. judgmental sampling
   b. quota sampling
c. snowball sampling
d. stratified sampling
e. convenience sampling

9. Which of the following is NOT an example of a commonly used probability sampling technique?
a. snowball sampling
b. systematic sampling
c. stratified sampling
d. cluster sampling
e. simple random sampling

10. A probability sampling technique in which the sample is chosen by selecting a random starting point and then picking every $i$th element in succession from the sampling frame is called _________.
a. simple random sampling
b. snowball sampling
c. cluster sampling
d. succession sampling
e. none of the above is correct

HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES

9-19. Review the discussion of target population and sampling frame in Chapter 9 in the text.

9-20. Review the discussion of target population and sampling frame and the discussion of sampling techniques in Chapter 9 in the text. Also review the section on probability sampling techniques.

9-21. Think of where you could go to get information on the desired city (Los Angeles) and what demographic information you’ll need.

9-23. Search the Internet to locate such a program.

9-24. Review the section on Internet sampling.

EXTRA MATERIALS
A Graphical Illustration of Non-Probability Sampling Techniques

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6</td>
<td>11</td>
<td>16</td>
<td>21</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>12</td>
<td>17</td>
<td>22</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td>13</td>
<td>18</td>
<td>23</td>
</tr>
<tr>
<td>4</td>
<td>9</td>
<td>14</td>
<td>19</td>
<td>24</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>15</td>
<td>20</td>
<td>25</td>
</tr>
</tbody>
</table>

Group D happens to assemble at a convenient time and place. So all the elements in this Group are selected. The resulting sample consists of elements 16, 17, 18, 19, and 20. Note, no elements are selected from group A, B, C, and E.
### A Graphical Illustration of Non-Probability Sampling Techniques: Judgmental Sampling

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6</td>
<td>11</td>
<td>16</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>12</td>
<td>17</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td>13</td>
<td>18</td>
<td></td>
<td>23</td>
</tr>
<tr>
<td>4</td>
<td>9</td>
<td>14</td>
<td>19</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>15</td>
<td>20</td>
<td>25</td>
<td></td>
</tr>
</tbody>
</table>

The researcher considers groups B, C, and E to be typical and convenient. Within each of these groups, one or two elements are selected based on typicality and convenience. The resulting sample consists of elements 8, 10, 13, 22, and 24. Note, no elements are selected from groups A and D.

---

### A Graphical Illustration of Non-Probability Sampling Techniques: Quota Sampling

<table>
<thead>
<tr>
<th>Random Selection</th>
<th>Referrals</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>9</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
</tr>
</tbody>
</table>

A quota of one element from each group, A to E, is imposed. Within each group, one element is selected based on judgment or convenience. The resulting sample consists of elements 3, 6, 13, 20, and 22. Note, one element is selected from each column or group.
### A Graphical Illustration of Non-Probability Sampling Techniques: Snowball Sampling

<table>
<thead>
<tr>
<th>Random Selection</th>
<th>Referrals</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>9</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
</tr>
</tbody>
</table>

Elements 2 and 9 are selected randomly from groups A and B. Element 2 refers to elements 12 and 13. Element 9 refers to element 18. The resulting sample consists of elements 2, 9, 12, 13, and 18. Note, there is no element from group E.

### A Graphical Illustration of Probability Sampling Techniques: Simple Random Sampling

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6</td>
<td>11</td>
<td>16</td>
<td>21</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>12</td>
<td>17</td>
<td>22</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td>13</td>
<td>18</td>
<td>23</td>
</tr>
<tr>
<td>4</td>
<td>9</td>
<td>14</td>
<td>19</td>
<td>24</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>15</td>
<td>20</td>
<td>25</td>
</tr>
</tbody>
</table>

Select five random numbers from 1 to 25. The resulting sample consists of population elements 3, 7, 9, 16, and 24. Note, there is no element from Group C.
### A Graphical Illustration of Probability Sampling
#### Techniques Systematic Sampling

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6</td>
<td>11</td>
<td>16</td>
<td>21</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>12</td>
<td>17</td>
<td>22</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td>13</td>
<td>18</td>
<td>23</td>
</tr>
<tr>
<td>4</td>
<td>9</td>
<td>14</td>
<td>19</td>
<td>24</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>15</td>
<td>20</td>
<td>25</td>
</tr>
</tbody>
</table>

Select a random number between 1 to 5, say 2. The resulting sample consists of population 2, (2+5=) 7, (2+5x2=) 12, (2+5x3=) 17, and (2+5x4=) 22. Note, all the elements are selected from a single row.

### A Graphical Illustration of Probability Sampling
#### Techniques Stratified Sampling

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6</td>
<td>11</td>
<td>16</td>
<td>21</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>12</td>
<td>17</td>
<td>22</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td>13</td>
<td>18</td>
<td>23</td>
</tr>
<tr>
<td>4</td>
<td>9</td>
<td>14</td>
<td>19</td>
<td>24</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>15</td>
<td>20</td>
<td>25</td>
</tr>
</tbody>
</table>

Randomly select a number from 1 to 5 for each stratum, A to E. The resulting sample consists of population elements 4, 7, 13, 19, and 21. Note, one element is selected from each column.
A Graphical Illustration of Probability Sampling Techniques Cluster Sampling (2-Stage)

Randomly select 3 clusters, B, D, and E. Within each cluster, randomly select one or two elements. The resulting sample consists of population elements 7, 18, 20, 21, and 23. Note, no elements are selected from clusters A and C.

Cluster Sampling vs. Stratified Sampling

**Cluster Sampling**
- Only a sample of the subpopulations (clusters) is selected for sampling.
- Within a cluster, elements should be different (heterogeneous), whereas homogeneity or similarity is maintained between different clusters.
- A sampling frame is needed only for the clusters selected for the sample.

**Stratified Sampling**
- All of the subpopulations (strata) are selected for sampling.
- Within a strata, elements should be homogeneous with clear differences (heterogeneity) between the strata.
- A complete sampling frame for the entire stratified subpopulations should be drawn.
## Strengths & Weaknesses of Basic Sampling Techniques

<table>
<thead>
<tr>
<th>Technique</th>
<th>Strengths</th>
<th>Weaknesses</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Nonprobability Sampling Techniques</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Convenience sampling</td>
<td>Least expensive; least time consuming; most convenient</td>
<td>Selection bias; sample not representative; not recommended for descriptive or causal research</td>
</tr>
<tr>
<td>Judgmental sampling</td>
<td>Low cost; convenient; not time consuming</td>
<td>No generalization; subjective</td>
</tr>
<tr>
<td>Quota sampling</td>
<td>Sample can be controlled for certain characteristics</td>
<td>Selection bias; No assurance of representativeness</td>
</tr>
</tbody>
</table>

## Strengths & Weaknesses of Basic Sampling Techniques (Cont.)

<table>
<thead>
<tr>
<th>Technique</th>
<th>Strengths</th>
<th>Weaknesses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snowball sampling</td>
<td>Can estimate rare characteristics</td>
<td>Time consuming</td>
</tr>
</tbody>
</table>

**Probability Sampling**

<table>
<thead>
<tr>
<th>Simple random sampling (SRS)</th>
<th>Easily understood; results projectable</th>
<th>Difficult to construct sampling frame; expensive; lower Precision; no assurance of representativeness</th>
</tr>
</thead>
</table>

| Systematic sampling          | Can increase representativeness; easier to implement than SRS; sampling frame not needed | Can decrease representativeness                                                                      |
### Strengths & Weaknesses of Basic Sampling Techniques (Cont.)

<table>
<thead>
<tr>
<th>Technique</th>
<th>Strengths</th>
<th>Weaknesses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stratified sampling</td>
<td>Includes all important subpopulations; precision</td>
<td>Difficult to select relevant stratification variables; not feasible to stratify on many variables; expensive</td>
</tr>
<tr>
<td>Cluster sampling</td>
<td>Easy to implement; cost effective</td>
<td>Imprecise difficult to compute and interpret results</td>
</tr>
</tbody>
</table>

### Choosing Nonprobability vs. Probability Sampling

<table>
<thead>
<tr>
<th>Conditions Favoring the Use of</th>
<th>Nonprobability Sampling</th>
<th>Probability Sampling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nature of research</td>
<td>Exploratory</td>
<td>Conclusive</td>
</tr>
<tr>
<td>Relative magnitude of sampling and nonsampling errors</td>
<td>Nonsampling errors are larger</td>
<td>Sampling errors are larger</td>
</tr>
<tr>
<td>Variability in the population</td>
<td>Homogeneous (low)</td>
<td>Heterogeneous (high)</td>
</tr>
<tr>
<td>Statistical considerations</td>
<td>Unfavorable</td>
<td>Favorable</td>
</tr>
<tr>
<td>Operational considerations</td>
<td>Favorable</td>
<td>Unfavorable</td>
</tr>
</tbody>
</table>
CHAPTER 10

DATA COLLECTION AND PREPARATION

LEARNING OBJECTIVES

1. Describe the field work or data collection process and explain the selection, training, and supervision of field workers, the validation of field work, and the evaluation of field workers.
2. Discuss the training of field workers in making the initial contact, asking the questions, probing, recording the answers, and terminating the interview.
3. Discuss the supervision of field workers in terms of quality control and editing, sampling control, control of cheating, and central office control.
4. Describe the evaluation of field workers in areas of cost and time, response rates, quality of interviewing, and the quality of data.
5. Discuss the nature and scope of data preparation, and the data preparation process.
6. Explain questionnaire checking and editing, and treatment of unsatisfactory responses by returning to the field, assigning missing values, and discarding unsatisfactory responses.
7. Describe the guidelines for coding questionnaires including the coding of structured and unstructured questions.
8. Discuss the data-cleaning process and the methods used to treat missing responses: substitution of a neutral value, casewise deletion, and pairwise deletion.
9. State the reasons for and methods of statistically adjusting data: variable respecification and recoding.
10. Describe the procedure for selecting a data analysis strategy and the factors influencing the process.
11. Explain the issues related to data collection and data preparation when conducting international marketing research.
12. Explain fieldwork and data preparation in relation to social media.
13. Discuss the ethical aspect of data collection and data preparation.
14. Describe the SPSS and Excel programs available for data entry, variable respecification, and variable recoding.

CHAPTER OUTLINE

1. Overview
2. The Nature of Fieldwork
3. Fieldwork/Data Collection Process
4. Selection of Field Workers
5. Training of Field Workers

Copyright © 2015 Pearson Education, Inc.
i. Making the Initial Contact
ii. Asking the Questions
iii. Probing
iv. Recording the Answers
v. Terminating the Interview
6. Supervision of Field Workers
   i. Quality Control and Editing
   ii. Sampling Control
   iii. Control of Cheating
   iv. Central Office Control
7. Validation of Fieldwork
8. Evaluation of Field Workers
   i. Cost and Time
   ii. Response Rates
   iii. Quality of Interviewing
   iv. Quality of Data
9. The Data Preparation Process
10. Questionnaire Checking
11. Editing
12. Coding
   i. Coding Structured Questions
   ii. Coding Unstructured Questions
   iii. Codebook
13. Transcribing
   i. Developing a Data File
14. Data Cleaning
   i. Consistency Checks
   ii. Treatment of Missing Responses
15. Statistically Adjusting the Data
16. Selecting a Data Analysis Strategy
17. International Marketing Research
18. Social media and Marketing Research
19. Ethics in Marketing Research
20. Software Applications
   i. SPSS and Excel Computerized Demonstration Movies
   ii. SPSS and Excel Screen Captures with Notes
21. SPSS Windows
   i. Detailed Steps: Overview
   ii. Detailed Steps: Data Entry
   iii. Detailed Steps: Variable Respecification
   iv. Detailed Steps: Variable Recoding
22. Excel
   i. Detailed Steps: Overview
   ii. Detailed Steps: Data Entry
   iii. Detailed Steps: Variable Respecification
LEARNING TIPS

Focus on the issues identified in the following for each learning objective.

Learning Objective 1

* The components of the fieldwork process.

See Figure 10.2 for a depiction of the fieldwork process.

* Highlight problems in the selection of field workers.

Learning Objective 2

* The motivation for and the content of field worker training.

Learning Objective 3

* The rationale for supervising fieldwork.

Learning Objective 4

* The rationale for the evaluation of field workers.

* The factors on which field workers should be evaluated.

Learning Objective 5

* The steps involved in the data preparation process and the importance of this phase in a marketing research project.
Learning Objective 6

* The rationale and the procedure involved in questionnaire checking.
* The steps involved in editing a questionnaire.
* How unsatisfactory responses are treated. For each method, explain the conditions in which it is best used.

Learning Objective 7

* The coding process for unstructured questions.
* The utility of a code book.

*Figure 10.8 provides an example of a codebook.*

Learning Objective 8

* The motivation for data cleaning.

Learning Objective 9

* The purpose and methodology for each statistical data adjustment technique.

Learning Objective 10

* The factors influencing the selection of a data analysis strategy.

Learning Objective 11

* Special problems with the use of locals in international fieldwork.
* The special international concerns with data preparation.

**Learning Objective 12**

* Fieldwork in relation to social media.
* Text coding and categorization and other aspects of data preparation in social media research.

**Learning Objective 13**

* Ethical responsibilities to the client and respondents.
* The ethical concerns while cleaning data.
* The ethical concerns in data analysis and interpretation.

**Learning Objective 14**

* How to run the relevant SPSS and Excel analyses.
* SPSS and Excel Computerized Demonstrations.
* SPSS and Excel Screen Captures with Notes.

**TRUE/FALSE QUESTIONS**

1. Field work is the step in the research process immediately after determining the research design.

2. Researchers have two major choices for collecting their data: use their own organization or hire a data collection agency.
3. According to the text, the typical interviewer is a single woman ages 35-54, with an above-average education and an above-average household income.

4. Validating the interview is not recognized as a phase of the interviewing process.

5. Supervision of field workers does not include coding of questionnaires.

6. Selecting a final data analysis strategy is the last stage of the data preparation process.

7. Editing consists of screening questionnaires to identify illegible, incomplete, inconsistent, or ambiguous responses.

8. According to the text, the symbols used in the assignment of codes to each possible response to each question is usually a letter or special character.

9. Categories are mutually exclusive if each response fits into one and only one category code.

10. Casewise deletion is the only useful option available for the treatment of missing responses.

MULTIPLE CHOICE QUESTIONS

1. According to the text, field work immediately follows ____ in the marketing research process.
   a. problem definition
   b. approach to problem
   c. research design
   d. data preparation
   e. report preparation

2. Which of the following is NOT recognized as a field worker?
   a. an interviewer intercepting shoppers in a mall
   b. a worker who does data entry
   c. a telephone interviewer calling from a central location
   d. an observer counting customers in a particular section of a store
   e. a worker mailing questionnaires from an office

3. Which of the following are mentioned in the text as elements related to the field work process?
   a. the selection of field workers
   b. the validation of field work
   c. the compensation of field workers
   d. a and b above
4. The first step in the fieldwork process is ____.
   a. the training of field workers
   b. the supervision of field workers
   c. the evaluation of field workers
   d. the validation of field workers
   e. none of the above is correct.

5. The "general rule" for recording answers to unstructured questions is to ____.
   a. summarize the responses
   b. filter the responses using your own background
   c. interpret the responses
   d. select the responses that seem correct
   e. none of the above is correct

6. In the marketing research process, data preparation and analysis comes immediately after ____ and before ____.
   a. problem definition; research design
   b. research design; field work
   c. field work; research design
   d. problem definition; report preparation
   e. None of the above is correct

7. Assigning a number or letter to each possible response to a questionnaire is called ____.
   a. editing
   b. coding
   c. validating
   d. pretesting
   e. transcribing

8. Which of the following is NOT an alternative for the treatment of unsatisfactory responses?
   a. return the questionnaire to the field to get better data
   b. assign missing values
   c. discard unsatisfactory respondents
   d. try to guess what respondents meant
   e. c and d above

9. Which of the following is a stage of the data preparation process?
   a. questionnaire checking
   b. editing
   c. transcribing
   d. data cleaning
   e. All of the above are correct
10. Coding _____ questions is relatively difficult since the response options are not predetermined.
   a. structured
   b. open-ended
   c. concept
   d. free-flowing
   e. uniform

HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES

10-19. Think of how to make the initial contact, how to ask questions, how to probe, how to record answers and how to terminate the interview. Try to be as specific as possible.

10-20. For this question, you should review supervision, validation and evaluation of field workers in Chapter 10 in the text.

10-21. You should follow the guidelines for coding schemes in the text. Consider whether your numeric codes are exhaustive and mutually exclusive. For Q9 and Q10, how many separate variables are there?

10-24. You will need to be able to identify data that are out of range, or have extreme values, as described in the text.

EXTRA MATERIALS
General Qualifications of Field Workers

- **Healthy.** Field workers must have the stamina required to do the job.
- **Outgoing.** The interviewers should be able to establish rapport with the respondents.
- **Communicative.** Effective speaking and listening skills are a great asset.
- **Pleasant appearance.** If the field worker's physical appearance is unpleasant or unusual, the data collected may be biased.
- **Educated.** Interviewers must have good reading and writing skills.
- **Experienced.** Experienced interviewers are likely to do a better job.

Commonly Used Probes and Abbreviations

<table>
<thead>
<tr>
<th>Standard Interviewer's Probe</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any other reason?</td>
<td>(AO?)</td>
</tr>
<tr>
<td>Any others?</td>
<td>(Other?)</td>
</tr>
<tr>
<td>Anything else?</td>
<td>(AE or Else?)</td>
</tr>
<tr>
<td>Could you tell me more about your thinking on that?</td>
<td>(Tell more)</td>
</tr>
<tr>
<td>How do you mean?</td>
<td>(How mean?)</td>
</tr>
<tr>
<td>Repeat question</td>
<td>(RQ)</td>
</tr>
<tr>
<td>What do you mean?</td>
<td>(What mean?)</td>
</tr>
<tr>
<td>Which would be closer to the way you feel?</td>
<td>(Which closer?)</td>
</tr>
<tr>
<td>Why do you feel that way?</td>
<td>(Why?)</td>
</tr>
<tr>
<td>Would you tell me what you have in mind?</td>
<td>(What in mind?)</td>
</tr>
</tbody>
</table>
Data Transcription

- Raw Data
  - CATI/CAPI
  - Key Punching via CRT Terminal
  - Mark Sense Forms
  - Optical Scanning
  - Computerized Sensory Analysis
  - Verification: Correct Key Punching Errors
- Computer Memory
- Disks
- Magnetic Tapes
- Transcribed Data

Selecting a Data Analysis Strategy

1. Earlier Steps (1, 2, 3) of the Marketing Research Process
2. Known Characteristics of Data
3. Properties of Statistical Techniques
4. Background & Philosophy of the Researcher
5. Data Analysis Strategy
CHAPTER 11

DATA ANALYSIS: FREQUENCY DISTRIBUTION, HYPOTHESIS TESTING AND CROSS-TABULATION

LEARNING OBJECTIVES

1. Understand why preliminary data analysis is desirable and the insights that can be obtained from such an analysis.
2. Explain what is meant by frequency counts and what measures are associated with such an analysis.
3. Describe the general procedure for hypothesis testing and the steps involved.
4. Discuss how cross-tabulation analysis should be conducted and the associated statistics.
5. Understand how the chi-square statistic is calculated and the purpose for which it is used.
6. Discuss the other statistics used to test association between two variables and when they are used.
7. Describe the SPSS and Excel programs available for conducting frequency and cross-tabulation analyses.

CHAPTER OUTLINE

1. Overview
2. Frequency Distribution
3. Statistics Associated with Frequency Distribution
   i. Measures of Location
   ii. Measures of Variability
4. Introduction to Hypothesis Testing
5. A General Procedure for Hypothesis Testing
   i. Step 1: Formulating the Hypothesis
   ii. Step 2: Selecting an Appropriate Test
   iii. Step 3: Choosing Level of Significance
   iv. Step 4: Data Collection
   v. Step 5: Determining the Probability
   vi. Steps 6 and 7: Comparing the Probability and Making the Decision
   vii. Step 8: Marketing Research Conclusion
6. Cross-tabulations
7. Statistics Associated with Cross-Tabulation
   i. Chi-Square
LEARNING TIPS

Focus on the issues identified in the following for each learning objective.

**Learning Objective 1**

* The significance of preliminary data analysis.

**Learning Objective 2**

* The motivation for the frequencies procedure.

_See Figure 11.3 and Table 11.2 for an example of a frequency distribution and its associated data distribution._

* Differentiate the three measures of location.

* The various measures of variability.
Chapter Objective 3
* The general procedure for hypothesis testing.

Chapter Objective 4
* The cross-tabulations procedure.

   See Tables 11.4 and 11.5 for an example of two variable cross-tabulation.

* The statistics used to assess the significance and strength in cross-tabulation.

Learning Objective 5
* The chi-square statistics used to assess the significance in cross-tabulation.

   See Figure 11.9 for an example of hypothesis testing with a chi-square test.

Learning Objective 6
* The statistics used to assess the strength in cross-tabulation.

Learning Objective 7
* The computer programs available for frequencies.
* The computer programs available for cross-tabulation.
* The SPSS programs available for frequencies and cross-tabulations.

Computer Software Demonstrations
* SPSS and Excel Computerized Demonstrations.
TRUE/FALSE QUESTIONS

1. The mode is a good measure of location when the variable is categorical.

2. The measure of central tendency given as the middle value when the distribution is arrayed from highest to lowest score is the median.

3. According to the text, the range is a good measure of central tendency.

4. The null hypothesis is a statement of the status quo, one of no difference or no effect.

5. The test of the null hypothesis is a two-tailed test when the alternative hypothesis is not expressed directionally.

6. In commercial marketing research, the one-tailed test is used less often than a two-tailed test.

7. A univariate hypothesis test using the standard normal distribution is called the chi-square test.

8. The level of Type I error is also called level of significance.

9. The value of the test statistic should always be greater than mid-point of the scale.

10. If the probability associated with the test statistic is larger than the level of significance, the null hypothesis is not rejected.

MULTIPLE CHOICE QUESTIONS

1. A frequency distribution ______.
   a. is always symmetrical
   b. indicates the shape of the empirical distribution of the variable.
   c. contains the same information as the margins of a contingency table
   d. a and b only
   e. b and c only
2. Which of the following is NOT a statistic that is associated with the measures of location of frequency distribution?
   a. mean
   b. mode
   c. median
   d. range
   e. c and d

3. Which of the following is what most people think of as "the average" using an interval or ratio scale?
   a. mode
   b. median
   c. mean
   d. maxima
   e. trend

4. According to the text, which of the following represents the value that occurs most and is the highest peak of the distribution?
   a. mode
   b. mean
   c. median
   d. maxima
   e. crest

5. Suppose that you were looking at a distribution of "home value" measured in dollars. The _____ should be used as the measure of location since the distribution is asymmetric.
   a. mean
   b. mode
   c. median
   d. maxima
   e. ranking order

6. A statistic that indicates the distribution's dispersion is called _____.
   a. measures of location
   b. measures of association
   c. measures of relativity
   d. measures of difference
   e. none of the above is correct

7. According to the text, the _____ measures the spread of the data.
   a. mode
   b. median
   c. mean
   d. body
e. none of the above is correct

8. The _____ is always the hypothesis that is tested, but can never be accepted based on a single test.
   a. alternative hypothesis
   b. random hypothesis
   c. research hypothesis
   d. standardized hypothesis
   e. null hypothesis

9. _____ occurs when the sample results lead to not rejecting a null hypothesis that is in fact false.
   a. Type I error
   b. Type II error
   c. Type III error
   d. Type IV error
   e. Power of a test

10. The chi-square test is often used in which of the following analyses?
    a. cross tabulation
    b. regression analysis
    c. frequency distribution
    d. test of means
    e. binary regression

HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES

11-12. Questions a through e are directional hypotheses involving a one-tailed test, and f involves a two-tailed test.

11-13. a. Review doing a cross-tabulation focusing on chi-square analysis and Cramer’s V.

       b. Use a hypothesis test for two independent samples for proportions to test if the proportions of the two populations are equal.


11-16. Review measures of location and measures of variability in the section on Frequency Distribution.

11-17. Review the use of chi-square analysis and the contingency coefficient.

11-18. a. Review measures of location and measures of variability in the section on Frequency Distribution.
   b. Review the use of chi-square analysis.

EXTRA MATERIALS
CHAPTER 12

DATA ANALYSIS: HYPOTHESIS TESTING RELATED TO DIFFERENCES, CORRELATION, AND REGRESSION

LEARNING OBJECTIVES

1. Understand the role of the \( t \) distribution in testing hypotheses that are related to differences.
2. Explain how to test the hypothesis related to one sample.
3. Describe how hypothesis testing changes when there are two independent samples rather than one, and when testing for difference in proportions rather than means.
4. Discuss how to test hypothesis for paired samples.
5. Explain the basic concepts of correlation and regression analyses.
6. Describe the SPSS and Excel programs available for conducting hypotheses testing related to differences, correlation and regression analyses.

CHAPTER OUTLINE

1. Overview
2. Hypothesis Testing Related to Differences
3. The \( t \) Distribution
   i. Testing Hypotheses Based on the \( t \) Statistic
4. One Sample
   i. Test for a Single Mean
   ii. Test for a Single Proportion
5. Two Independent Samples
   i. Means
   ii. Proportions
6. Paired Samples
   i. Means
   ii. Proportions
7. Correlation
8. Regression Analysis
   i. Multiple Regression Model
   ii. Strength of Association
   iii. Significance Testing
9. Software Applications
LEARNING TIPS

Focus on the issues identified in the following for each learning objective.

**Learning Objective 1**

* The theoretical basis for parametric tests.

**Learning Objective 2**

* One Sample Hypothesis Testing.

**Learning Objective 3**

* Two Sample Hypothesis Testing: Means.

* Two Sample Hypothesis Testing: Proportions.
See Table 12.3 for an example of a two independent sample t test.

**Learning Objective 4**

* Paired Sample Hypothesis Testing: Means.
* Paired Sample Hypothesis Testing: Proportions.

See Table 12.5 for an example of a paired sample t test.

**Learning Objective 5**

* The importance of product-moment correlation in regression analysis.
* The general multiple regression model and its associated statistics.

**Learning Objective 6**

* Discuss the computer programs for testing hypotheses related to means.
* Discuss the SPSS programs for testing hypotheses related to means.
* Discuss the SPSS programs available for correlation and regression.

**Computer Software Demonstrations**

* SPSS and Excel Computerized Demonstrations.
* SPSS and Excel Screen Captures with Notes.

**TRUE/FALSE QUESTIONS**
1. Non-parametric tests are hypothesis testing procedures that assume the variables of interest are measured on nominal or ordinal scales.

2. The most popular parametric test is the chi-square test conducted for examining hypotheses about means.

3. The $t$ statistic is calculated by assuming that the mean is unknown.

4. The $t$ distribution is a non-symmetrical distribution that is useful for small sample testing.

5. Two samples that relate to the same respondents are called paired samples.

6. An $F$-test may be performed if it is not known whether the two populations have equal variance.

7. A two-tailed test is less conservative than the corresponding one-tailed test.

8. A test for differences in the means of paired sampled is called the independent samples $t$-test.

9. A statistic summarizing the strength of association between two metric variables is called the simple regression correlation.

10. The strength of association in regression analysis is measured by the beta weight.

**MULTIPLE CHOICE QUESTIONS**

1. The most popular test conducted for examining hypotheses about variances is the ____.
   a. $F$-test
   b. $p$-test
   c. $t$-test
   d. $z$-test
   e. chi-square

2. The ____ is a statistic that assumes that the variable has a symmetric bell-shaped distribution and the mean is known, and the population variance is known.
   a. $a$ statistic
   b. $p$ statistic
   c. $F$ statistic
   d. $z$ statistic
   e. bell statistic

3. The ____ is a symmetric bell-shaped distribution that is useful for small samples or when variance is unknown.
a. $F$ distribution  

b. $p$ distribution  

c. $t$ distribution  

d. $z$ distribution  

e. chi-square distribution  

4. Two samples that are related are best referred to as _____.  
   a. paired samples  
   b. dependent samples  
   c. parallel samples  
   d. exclusive samples  
   e. non-experimental samples  

5. A(n) ____ of sample variance may be performed if it is not known whether the two populations have equal variance.  
   a. $p$-test  
   b. $t$-test  
   c. $z$-test  
   d. chi-square test  
   e. none of the above is correct  

6. Examples of hypotheses related to paired samples include all of the following EXCEPT:  
   a. Shoppers consider brand name to be more important than price while purchasing fashion clothing.  
   b. Households spend more money on pizza than they do on hamburgers.  
   c. The proportion of households who subscribe to a daily newspaper exceeds the proportion subscribing to magazines.  
   d. Male consumers spend more on a product than do female consumers.  
   e. The proportion of a bank's customers who have a checking account exceeds the proportion who has a savings account.  

7. The ____ is a statistic that assumes that the variable has a symmetric bell-shaped distribution and the mean is known, and the population variance is unknown.  
   a. $t$ statistic  
   b. $p$ statistic  
   c. $F$ statistic  
   d. $z$ statistic  
   e. bell statistic  

8. ______ is a statistical procedure for analyzing associative relationships between two metric variables.  
   a. Analysis of variance  
   b. Covariance analysis  
   c. Deviation analysis  
   d. Correlation analysis
e. Functional linear analysis

9. The term used to denote the standardized regression coefficient in multiple regression is called the ______ coefficient.
   a. alpha
   b. beta
   c. gamma
   d. theta
   e. partial regression

10. According to the text, hypotheses related to differences in population means if the population variance is known can be tested using the ____.
    a. $F$ distribution
    b. $p$ distribution
    c. t distribution
    d. $z$ distribution
    e. chi-square distribution

**HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES**

12-12. The key to these questions is to determine level of measure used and number of independent groups.

12-13. This question deals with test for a single proportion. Review the section on A General Procedure for Hypothesis Testing given in Chapter 16.

12-14. This question deals with test for a single mean. Review the section on Test for a Single Mean.

12-15. Review the section on Testing Hypothesis for More Than Two Samples.

12-16. Review the sections on Testing Hypothesis for One Sample and More Than Two Samples.

12-17. Review the sections on Testing Hypothesis for One Sample and More Than Two Samples.

12-18. Review the sections and Correlation and Regression Analysis.

12-19. Review the sections and Correlation and Regression Analysis.
The Decision to Reject the Null Hypothesis: One-Tailed and Two-Tailed Tests

(a) One-tailed test

(b) Two-tailed test

Figure 12.5: A Concept Map for Conducting t-Tests

Hypothesis Testing

H₀ and H₁

guided by

H₀ reflects status quo whereas H₁ is one in which an effect is expected

Appropriate t-Test

consider

choose

Level of Significance, α

collect data

calculate the appropriate t-Statistic

determine

Probability Associated with t-Statistic (TS calc)

compare with

Level of Significance, α (α/2)

results in

Reject or Do Not Reject H₀

if H₀ is not rejected

Marketing Research Conclusion

if H₀ is rejected

recommend status quo

recommend action implied by H₁

Type-I Error, α and Type-II Error, β

α = 0.05

Copyright © 2014 Pearson Education, Inc. Publishing as Prentice Hall

Chapter 11 - 1

Chapter 12 - 2
CHAPTER 13

REPORT PREPARATION AND PRESENTATION

LEARNING OBJECTIVES

1. Understand the process that should be followed in preparing and presenting the final report.
2. Explain the guidelines available for writing a report that includes graphs and tables.
3. Describe how an oral presentation should be made and some of the principles involved.
4. Discuss the importance of follow-up with the client, and the assistance that should be given to the client in implementing and evaluating the research project.
5. Explain how the report preparation and presentation process differs in international marketing research.
6. Describe how social media facilitate and enhance report preparation and presentation.
7. Discuss the ethical issues related to the interpretation and reporting of the research process and findings.

CHAPTER OUTLINE

1. Overview
2. Importance of the Report and Presentation
3. The Report Preparation and Presentation Process
   i. Report Format
   ii. Report Writing
   iii. Guidelines for Tables
   iv. Guidelines for Graphs
4. Oral Presentation and Dissemination
5. Research Follow-Up
   i. Evaluating the Research Project
   ii. Assisting the Client
6. International Marketing Research
7. Social media and Marketing Research
8. Ethics in Marketing Research
9. Summary
10. Key Terms and Concepts
11. Acronyms
LEARNING TIPS

Focus on the issues identified in the following for each learning objective.

**Learning Objective 1**

* The importance of report presentation.

* The process of report preparation.

* How the format provided in the chapter parallels the marketing research process.

*Figure 13.2 may be used as a framework for this discussion.*

**Learning Objective 2**

* The guidelines for report writing and provide examples of well-written reports.

* The different types of graphs and mention situations when they are useful and the drawbacks of each.

**Learning Objective 3**

* Importance of making an effective oral presentation.

* The keys to an effective presentation.

* The “Tell ‘Em” and “KISS ‘Em” principles.

**Learning Objective 4**

* The tasks faced by the researcher during the follow-up action after the submission of the report.
Learning Objective 5

* The problems associated with preparing reports for foreign managers.

Learning Objective 6

* How social media can enhance report preparation and presentation.

Learning Objective 7

* The ethical responsibilities of the researcher and the client.

TRUE/FALSE QUESTIONS

1. Data analysis is the last step in the marketing research project.

2. A report prepared for top management should emphasize the strategic aspects of the results.

3. A letter of authorization authorizes the client to proceed with the project and specifies its scope and terms of the contract.

4. According to the text, only the most important tables should have a number and title.

5. Dots or hyphens that are used to impart uniformity and improve readability of a table are called leaders.

6. As a general rule, graphic aids should be used very sparingly in a report.

7. A graphical depiction that makes use of small pictures or symbols to display the data is called a schematic figures chart.

8. As a general guideline, a pie chart should not use more than seven sections.

9. Flow charts can be used to display the steps or components of a process.

10. Unexpectedly low response rates should not be reported to the client, since that may damage the credibility of the research report.
MULTIPLE CHOICE

1. ______ is the last step in the marketing research project.
   a. Data collection
   b. Questionnaire coding
   c. Data analysis
   d. Research design
   e. None of the above is correct

2. Which of the following is NOT a step in the report preparation and presentation process?
   a. secondary analysis
   b. data analysis
   c. oral presentation
   d. research follow-up
   e. interpretations, conclusions, and recommendations

3. According to the text, research follow-up is part of the ______ process.
   a. problem definition
   b. data analysis
   c. recommendations
   d. report preparation and presentation
   e. consultation

4. The executive summary should concisely describe all of the following EXCEPT:
   a. the problem
   b. the approach
   c. the research design
   d. detailed statistical tests
   e. major results

5. Which of the following is (are) a suggestion (suggestions) to follow when writing a marketing research report?
   a. Technical jargon should be used.
   b. The report should be easy to follow
   c. Objectivity should guide report writing
   d. Reinforce key information in the text with tables, graphs, and pictures.
   e. b, c, and d above are all correct

6. A round chart divided into sections is called a ______.
   a. circle chart
   b. line chart
   c. pictograph
   d. histogram
   e. none of the above is correct
7. To show the distribution of students by major in a class, one should best use a ______.
   a. line chart
   b. pictograph
   c. flow chart
   d. pie chart
   e. line out

8. To show sales trends over time, one should use a ______.
   a. bar chart
   b. histogram
   c. line chart
   d. pie chart
   e. streamline

9. According to the text, preparation is a key to ______.
   a. advanced technology use
   b. an effective presentation
   c. detailed descriptions of concepts
   d. professionalism
   e. future employment

10. A principle that is effective for structuring a presentation is:
    a. "go for it"
    b. "slide and glide"
    c. “fourth and goal”
    d. “preach it”
    e. "kiss ‘em"

HINTS FOR APPLIED PROBLEMS AND INTERNET EXERCISES

13-15. Do you think that this target audience will be able to fully understand the paragraph? Can you make it clearer and less complicated?

13-16. Many different flow charts can be drawn to represent this process. Look at the Concept Map in the Extra Materials of this Chapter to give you an idea of how to do this.

13-17. These should approximate the charts in the text.

13-18. The guidelines can vary but most should contain the essential elements discussed in this chapter.
13-19. The format of the report can vary but it should contain the essential elements discussed in this chapter.

EXTRA MATERIALS
Answers to
True-False/Multiple Choice Questions

Chapter 1

True-False
1. True
2. True
3. True
4. True
5. True
6. True
7. True
8. False
9. True
10. False

Multiple Choice
1. e
2. e
3. d
4. b
5. a
6. e
7. d
8. e
9. c
10. e

Chapter 2

True-False
1. True
2. True
3. True
4. False
5. True
6. True
7. False
8. False
9. True
10. False
Multiple Choice
1. a
2. e
3. b
4. e
5. e
6. d
7. a
8. e
9. b
10. e

Chapter 3

True-False
1. False
2. True
3. False
4. True
5. True
6. True
7. True
8. True
9. False
10. False

Multiple Choice
1. a
2. a
3. a
4. a
5. d
6. d
7. d
8. e
9. a
10. e

Chapter 4

True-False
1. True
2. True
3. True
4. False
5. False
6. False
7. False
8. False
9. True
10. False

Multiple Choice
1. a
2. b
3. e
4. e
5. e
6. d
7. e
8. d
9. e
10. b

Chapter 5

True-False
1. False
2. False
3. True
4. True
5. True
6. True
7. False
8. True
9. False
10. True

Multiple Choice
1. e
2. d
3. b
4. b
5. e
6. c
7. c
8. d
Chapter 6

True-False
1. False
2. False
3. True
4. True
5. True
6. True
7. False
8. False
9. True
10. False

Multiple Choice
1. e
2. b
3. e
4. d
5. b
6. a
7. e
8. a
9. c
10. a

Chapter 7

True-False
1. False
2. True
3. False
4. False
5. False
6. True
7. True
8. False
9. False
10. False
Multiple Choice
1. e
2. c
3. c
4. e
5. e
6. e
7. b
8. d
9. d
10. e

Chapter 8

True-False
1. True
2. True
3. False
4. True
5. False
6. False
7. True
8. False
9. False
10. True

Multiple Choice
1. d
2. e
3. e
4. e
5. d
6. e
7. e
8. e
9. e
10. b

Chapter 9

True-False
1. True
2. True
3. True
4. False
5. False
6. True
7. False
8. True
9. False
10. False

Multiple Choice
1. e
2. e
3. e
4. e
5. b
6. b
7. a
8. d
9. a
10. e

Chapter 10

True-False
1. True
2. True
3. False
4. True
5. False
6. True
7. True
8. False
9. True
10. False

Multiple Choice
1. c
2. b
3. d
4. e
5. e
6. e
7. b
8. d
9. e
10. b

Chapter 11

True-False
1. True
2. True
3. False
4. True
5. True
6. False
7. False
8. True
9. False
10. True

Multiple Choice
1. e
2. d
3. c
4. a
5. a
6. e
7. e
8. e
9. b
10. a

Chapter 12

True-False
1. True
2. False
3. False
4. False
5. True
6. True
7. False
8. False
9. False
10. False

Multiple Choice
Chapter 13

True-False
1. False
2. True
3. False
4. False
5. True
6. False
7. False
8. True
9. True
10. False

Multiple Choice
1. e
2. a
3. d
4. d
5. e
6. e
7. d
8. c
9. b
10. e
Cases
Case 1.1

Dell Direct

HINTS FOR SELECTED QUESTIONS

Chapter 10


Chapter 11

1. Frequency analysis is shown in the Book and in the Technology Manual section of the Student Resource Manual in section 11.1. It is useful to examine the frequency distribution of each variable.

2 – 3. Cross tabulation is shown in the Book and in the Technology Manual section of the Student Resource Manual in section 11.3.

Chapter 12

1. The one-sample t test should be conducted as shown in the Book and in the Technology Manual section of the Student Resource Manual in section 12.1.

2 - 4. Independent samples t tests would be appropriate and an example is shown in the Book and in the Technology Manual section of the Student Resource Manual for Chapter 12 in section 12.2

5 - 7. The appropriate test is a one-tailed paired samples t test. See the Book and the Technology Manual section of the Student Resource Manual for Chapter 12 for an example of a paired samples t, section 12.3.

8 – 9. For each of these conduct multiple regression analysis. See the Book and the Technology Manual section of the Student Resource Manual for Chapter 12, section 12.6.
Case 2.1

American Idol: A Big Hit for Marketing Research?

HINTS FOR SELECTED QUESTIONS

Critical Thinking Questions

1. - 8. Suggestions for answering these are provided for each one in the case questions.

Technical Questions

Chapter 1

9. Carefully review the marketing research process.

10. Review Chapter 1 in the text.

Chapter 2

11. The key here is to differentiate the management decision problem from the marketing research problem.

Chapter 3

12. Think of how different research methods may be employed in this situation.

13. Syndicated and other secondary data sources are reviewed in Chapter 3.

Chapter 4

14. Review the various qualitative research methods in Chapter 4.

Chapter 5

15. Consider advantages and disadvantages of various data collection methods. (See Table 5.1 for comparison).

Chapter 6

© 2015 by Pearson Education
16. Think of the reasons associated with the major basic research designs. (See Chapter 3). See also conditions for causality in Chapter 6.

Chapter 7
17. Think of what measures need to be assessed in this case. (See Chapter 9).

Chapter 8
18. You should be able to answer the “who, what, when, and where” questions.

Chapter 9
19. You will need to visit the Web site www.orcinternational.com and locate information on CARAVAN.

Chapter 10
20. You will need to visit the Web site www.orcinternational.com and locate information on CARAVAN.
Chapter 10 provides a good discussion of data collection management issues.

Chapter 13
21. Are there things you could do to validate the findings? Can you critically evaluate the research design employed?
Case 3.1

JPMorgan Chase: Chasing Growth Through Mergers and Acquisitions

HINTS FOR SELECTED QUESTIONS

Chapter 7

11. Consider using a series of Likert scale items. Think of dimensions that people would use in evaluating a bank.

Chapter 9

13. The key here is to first think of defining the population in question. What sampling plan and sample size were used in the past? Think of whether you would modify that or not. Would that sample size be adequate statistically?

Chapter 10

16-18. The procedure for this is shown in the Book and in the Technology Manual section of the Student Resource Manual for Chapter 10.

Chapter 11

20-21. Before attempting these two questions, consider the levels of measurement involved. Based on that, how could you use cross-tabulation? The procedure for this is shown in the Book and in the Technology Manual section of the Student Resource Manual for Chapter 11.

Chapter 12
22-23. Think of whether the proper analysis will be an independent samples or paired $t$ tests. The procedure for this is shown in the Book and in the Technology Manual section of the Student Resource Manual for Chapter 12.

24-25. A major consideration here is whether the test should be one- or two tailed. Think of whether the proper analysis will be an independent samples or paired $t$ tests. The procedure for this is shown in the Book and in the Technology Manual section of the Student Resource Manual for Chapter 12.

26-27. Consider using multiple regression analysis here. If so, how would you determine the significance of the model? How would you interpret the results for each variable? The procedure for this is shown in the Book and in the Technology Manual section of the Student Resource Manual for Chapter 12.
HINTS FOR SELECTED QUESTIONS

Chapter 10

15. The key here is to consider the proportion of missing values per variable. The greater the proportion, the more serious this issue becomes. Options for treatment of missing values are discussed in Chapter 10 in the section entitled Treatment of Missing Responses.


Chapter 11

22. Frequency analysis is shown in the Book and in the Technology Manual section of the Student Resource Manual for Chapter 11 in example 11.1. It is useful to examine the frequency distribution of each variable.

23-25. Cross tabulation is shown in the Book and in the Technology Manual section of the Student Resource Manual for Chapter 11 in example 11.3.

Chapter 12

26. Independent samples $t$ tests would be appropriate and an example is shown in the Book and in the Technology Manual section of the Student Resource Manual for Chapter 12. See example 12.2 in the Technology Manual.

27. The appropriate test is a one-tailed paired samples $t$ test. See the Book and in the Technology Manual section of the Student Resource Manual for Chapter 12 for an example of a paired samples $t$ test, example 12.3.
28-29. For each of these consider multiple regression analysis. See the Book and in the Technology Manual section of the Student Resource Manual for Chapter 12, example 12.6.
**FFFCU Example Database**

Function First Federal Credit Union (FFFCU) is a local financial institution with thirty branch offices. It has 137,000 credit union members and nearly $2 billion in assets. Landry Parker, Vice-President for Marketing, has conducted a member satisfaction survey for the past four years. In the survey, members rated their satisfaction with various aspects of the credit union, indicated their use of the internet and the FFFCU Web site and indicated various personal characteristics. Over 1000 members were surveyed each year.

The database results are from a sub-sample 406 respondents from the Downtown, Riverdale, The Heights, Palm City and South Town branch offices over the past four years.

The database is organized as follows:

<table>
<thead>
<tr>
<th>ID</th>
<th>Respondent identification number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>Year of survey from 1 to 4</td>
</tr>
<tr>
<td>Q1</td>
<td>Branch used most often (Downtown = 1, Riverdale= 2, The Heights = 3, Palm City = 4, South Town = 5, don’t use a branch office = 6)</td>
</tr>
<tr>
<td>Q2</td>
<td>Satisfaction with FFFCU staff on product knowledge (1 = very dissatisfied, 6 = very satisfied)</td>
</tr>
<tr>
<td>Q3</td>
<td>Satisfaction with FFFCU on products and services offered</td>
</tr>
<tr>
<td>Q4</td>
<td>Satisfaction with FFFCU on accuracy of transactions</td>
</tr>
<tr>
<td>Q5</td>
<td>Satisfaction with FFFCU on information provided on products and services</td>
</tr>
<tr>
<td>Q6</td>
<td>Satisfaction with FFFCU on information provided on special promotions</td>
</tr>
<tr>
<td>Q7</td>
<td>Satisfaction with FFFCU on availability of methods used to access accounts</td>
</tr>
<tr>
<td>Q8</td>
<td>Overall satisfaction with FFFCU</td>
</tr>
<tr>
<td>Q9</td>
<td>Has Internet access at home or work (1 = yes, 2= no)</td>
</tr>
<tr>
<td>Q10</td>
<td>Has visited FFFCU Web site in past year (1 = yes, 2= no)</td>
</tr>
<tr>
<td>Q11</td>
<td>Satisfaction with FFFCU Web site as source of information</td>
</tr>
<tr>
<td>Q12</td>
<td>How joined FFFCU (1 = through employment, 2 = Function County resident, 3 = relative of FFFCU member)</td>
</tr>
<tr>
<td>Q13</td>
<td>How long a member of FFFCU (1 = under one year, 2 = 1-3 years, 3 = over three years)</td>
</tr>
<tr>
<td>Q14</td>
<td>Age category (1 = under 25, 2 = 25-34, 3 = 35-54, 4 = 55-64, 5 = 65+)</td>
</tr>
<tr>
<td>Q15</td>
<td>Annual household income (1 = $20,000 and below, 2 = $20,001 – $25,000, 3 = $25,001 - $ 50,000, 4 = $50,001 - $75,000, 5 = $75,001 - $100,000, 6 = over $100,000)</td>
</tr>
<tr>
<td>Q16</td>
<td>Education level (1 = high school graduate or below, 2 = some college to college graduate, 3 = some graduate education to graduate degree)</td>
</tr>
</tbody>
</table>
RESEARCH QUESTIONS

Chapter 10

1. Can you create a total satisfaction index score by adding these six variables: satisfaction with FFFCU staff on product knowledge, satisfaction on products and services offered, satisfaction on accuracy of transactions, satisfaction on information provided on products and services, satisfaction on information provided on special promotions, satisfaction on availability of methods used to access accounts and dividing the sum by six?

2. Can you recode age into a new variable (new_age) by combining under 25 and 25-34 to create a category of under 35?

Chapter 11

1. What is the frequency distribution of Q8 “Rating of Satisfaction of FFFCU Overall”?

2. What are the mean, mode, median, standard deviation and variance for that question?

3. Does the proportion of members who have visited the FFFCU Web site vary significantly by age group?

Chapter 12

1. Is overall satisfaction significantly different from 5.0?

2. When comparing those who have internet access to those who do not, is there a significant difference in overall satisfaction?

3. Is there a significant paired difference in satisfaction of staff product knowledge and satisfaction with products and services available?

4. Is satisfaction with accuracy of transactions significantly correlated with overall satisfaction?

5. Build a bivariate regression with overall satisfaction as the dependent variable and satisfaction with accuracy of transactions as the independent variable.

6. Build a multiple regression model with overall satisfaction as the dependent variable and product knowledge, satisfaction on products and services offered, and satisfaction with FFFCU staff on product knowledge.
satisfaction on accuracy of transactions, satisfaction on information provided on products and services, satisfaction on information provided on special promotions, satisfaction on availability of methods used to access accounts and satisfaction with the Web site as source of information as the independent variables.
SPSS

Question 10.1

Transform $\rightarrow$ Compute variable $\rightarrow$ Target variable (index) $\rightarrow$ Numeric Expression $[Q2+Q3+Q4+Q5+Q6+Q7]/6$ $\rightarrow$ OK

![SPSS Compute Variable dialog box]

**Descriptive Statistics**

<table>
<thead>
<tr>
<th></th>
<th>N</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Mean</th>
<th>Std. Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>index</td>
<td>406</td>
<td>1.00</td>
<td>6.00</td>
<td>5.2590</td>
<td>.78749</td>
</tr>
<tr>
<td>Valid N (listwise)</td>
<td>406</td>
<td>1.00</td>
<td>6.00</td>
<td>5.2590</td>
<td>.78749</td>
</tr>
</tbody>
</table>
Question 10.2

Transform → Recode into Different Variables → Output Variable (New age = Recoded age) → Old and New Values → Old Value (1), New Value (2) → Add → Old Value (3), New Value (3) → Add → Old Value (4), New Value (4) → Add → Old Value (5), New Value (5) → Add → Continue
Questions 11.1 and 11.2

Analyze → Descriptive Statistics → Frequencies → Q8 → Statistics → Continue → Go

[Diagram of Frequencies window]

[Diagram of Frequencies: Statistics window]
### Statistics

**Overall Satisfaction of FFFCU**

<table>
<thead>
<tr>
<th>N</th>
<th>Valid</th>
<th>Missing</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>406</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Mean</th>
<th>Median</th>
<th>Mode</th>
<th>Std Deviation</th>
<th>Variance</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5.42</td>
<td>6.00</td>
<td>6</td>
<td>.965</td>
<td>.931</td>
</tr>
</tbody>
</table>

### Overall Satisfaction of FFFCU

<table>
<thead>
<tr>
<th></th>
<th>Frequency</th>
<th>Percent</th>
<th>Valid Percent</th>
<th>Cumulative Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid</td>
<td>8</td>
<td>2.0</td>
<td>2.0</td>
<td>2.0</td>
</tr>
<tr>
<td>very dissatisfied</td>
<td>3</td>
<td>.7</td>
<td>.7</td>
<td>2.7</td>
</tr>
<tr>
<td>dissatisfied</td>
<td>4</td>
<td>1.0</td>
<td>1.0</td>
<td>3.7</td>
</tr>
<tr>
<td>somewhat dissatisfied</td>
<td>29</td>
<td>7.1</td>
<td>7.1</td>
<td>10.8</td>
</tr>
<tr>
<td>somewhat satisfied</td>
<td>112</td>
<td>27.6</td>
<td>27.6</td>
<td>38.4</td>
</tr>
<tr>
<td>satisfied</td>
<td>250</td>
<td>61.6</td>
<td>61.6</td>
<td>100.0</td>
</tr>
<tr>
<td>very satisfied</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>406</td>
<td>100.0</td>
<td>100.0</td>
<td></td>
</tr>
</tbody>
</table>
Question 11.3

Analyze → Descriptive Statistics → Crosstabs → Q10 and Q14 → Cells → Statistics (Chi-square) → OK
### Age * Visited FFCU Website in Past Year? Crosstabulation

<table>
<thead>
<tr>
<th>Age</th>
<th>Count</th>
<th>% within Visited FFCU Website in Past Year?</th>
</tr>
</thead>
<tbody>
<tr>
<td>under 25</td>
<td>4</td>
<td>2.2%</td>
</tr>
<tr>
<td>25-34</td>
<td>23</td>
<td>15.3%</td>
</tr>
<tr>
<td>35-54</td>
<td>85</td>
<td>47.0%</td>
</tr>
<tr>
<td>55-64</td>
<td>30</td>
<td>16.4%</td>
</tr>
<tr>
<td>65 and over</td>
<td>35</td>
<td>19.1%</td>
</tr>
<tr>
<td>Total</td>
<td>183</td>
<td>100.0%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Visted FFCU Website in Past Year?</th>
<th>yes</th>
<th>no</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>yes</td>
<td>4</td>
<td>5</td>
<td>9</td>
</tr>
<tr>
<td>no</td>
<td>2.2%</td>
<td>2.2%</td>
<td>2.2%</td>
</tr>
<tr>
<td>Counts</td>
<td>23</td>
<td>18</td>
<td>46</td>
</tr>
<tr>
<td>% within Visited FFCU Website in Past Year?</td>
<td>15.3%</td>
<td>8.1%</td>
<td>11.3%</td>
</tr>
<tr>
<td>Counts</td>
<td>85</td>
<td>67</td>
<td>153</td>
</tr>
<tr>
<td>% within Visited FFCU Website in Past Year?</td>
<td>47.0%</td>
<td>30.0%</td>
<td>37.7%</td>
</tr>
<tr>
<td>Counts</td>
<td>30</td>
<td>48</td>
<td>78</td>
</tr>
<tr>
<td>% within Visited FFCU Website in Past Year?</td>
<td>16.4%</td>
<td>21.5%</td>
<td>19.2%</td>
</tr>
<tr>
<td>Counts</td>
<td>35</td>
<td>85</td>
<td>120</td>
</tr>
<tr>
<td>% within Visited FFCU Website in Past Year?</td>
<td>19.1%</td>
<td>38.1%</td>
<td>29.6%</td>
</tr>
<tr>
<td>Counts</td>
<td>183</td>
<td>223</td>
<td>406</td>
</tr>
</tbody>
</table>
Chi-Square Tests

<table>
<thead>
<tr>
<th></th>
<th>Value</th>
<th>df</th>
<th>Asymp. Sig. (2-sided)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pearson Chi-Square</td>
<td>25.943*</td>
<td>4</td>
<td>.000</td>
</tr>
<tr>
<td>Likelihood Ratio</td>
<td>26.395</td>
<td>4</td>
<td>.000</td>
</tr>
<tr>
<td>Linear-by-Linear Association</td>
<td>21.348</td>
<td>1</td>
<td>.000</td>
</tr>
<tr>
<td>N of Valid Cases</td>
<td>406</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*2 cells (20.0%) have expected counts less than 5. The minimum expected count is 4.06.
Question 12.1

Analyze → Compare means → One-Sample T-Test → 5.0 → OK

One-Sample Statistics

<table>
<thead>
<tr>
<th></th>
<th>N</th>
<th>Mean</th>
<th>Std. Deviation</th>
<th>Std. Error Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Satisfaction of FFFCU</td>
<td>405</td>
<td>5.42</td>
<td>.965</td>
<td>.048</td>
</tr>
</tbody>
</table>

One-Sample Test

<table>
<thead>
<tr>
<th></th>
<th>t</th>
<th>df</th>
<th>Sig. (2-tailed)</th>
<th>Mean Difference</th>
<th>95% Confidence Interval of the Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Satisfaction of FFFCU</td>
<td>8.845</td>
<td>405</td>
<td>.000</td>
<td>.424</td>
<td>[.33, .52]</td>
</tr>
</tbody>
</table>
Question 12.2

Analyze → Compare means → Independent samples T-test → Test Variable (Q8) → Grouping Variable Q9 (1,2) → OK

**Group Statistics**

<table>
<thead>
<tr>
<th>Has internet Access at Home or Work?</th>
<th>N</th>
<th>Mean</th>
<th>Std. Deviation</th>
<th>Std. Error Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Satisfaction of FFFCU</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>yes</td>
<td>235</td>
<td>5.40</td>
<td>.972</td>
<td>.058</td>
</tr>
<tr>
<td>no</td>
<td>121</td>
<td>5.49</td>
<td>.950</td>
<td>.088</td>
</tr>
</tbody>
</table>

**Independent Samples Test**

<table>
<thead>
<tr>
<th>Overall Satisfaction of FFFCU</th>
<th>0.004</th>
<th>0.000</th>
<th>0.005</th>
<th>0.006</th>
<th>-0.001</th>
<th>0.105</th>
<th>0.207</th>
<th>0.315</th>
</tr>
</thead>
<tbody>
<tr>
<td>95% Confidence Interval of the Mean</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lower</td>
<td>-0.296</td>
<td>0.113</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upper</td>
<td>0.296</td>
<td>0.113</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Question 12.3

Analyze → Compare means → Paired Samples T-Test → Q2 and Q3 → OK

Paired Samples Statistics

<table>
<thead>
<tr>
<th>Pair</th>
<th>Rating of FFFCU Product Knowledge</th>
<th>N</th>
<th>Std. Deviation</th>
<th>Std. Error Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>406</td>
<td>.856</td>
<td>.047</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pair</th>
<th>Rating of FFFCU Products and Services</th>
<th>N</th>
<th>Std. Deviation</th>
<th>Std. Error Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>406</td>
<td>.989</td>
<td>.049</td>
</tr>
</tbody>
</table>

Paired Samples Correlations

<table>
<thead>
<tr>
<th>Pair</th>
<th>Rating of FFFCU Product Knowledge &amp; Products and Services</th>
<th>N</th>
<th>Correlation</th>
<th>Sig</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>406</td>
<td>.576</td>
<td>.000</td>
</tr>
</tbody>
</table>

Paired Samples Test

<table>
<thead>
<tr>
<th>Pair</th>
<th>Rating of FFFCU Product Knowledge - Products and Services</th>
<th>Mean</th>
<th>Std. Deviation</th>
<th>Std. Error Mean</th>
<th>95% Confidence Interval of the Difference</th>
<th>t</th>
<th>df</th>
<th>Sig (2-tailed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>1.01</td>
<td>.896</td>
<td>.044</td>
<td>.180</td>
<td>2.272</td>
<td>405</td>
<td>.024</td>
</tr>
</tbody>
</table>
Question 12.4

![Bivariate Correlations dialog box]

**Correlations**

<table>
<thead>
<tr>
<th></th>
<th>Accuracy of Transactions</th>
<th>Overall Satisfaction of FFFCU</th>
</tr>
</thead>
</table>
| **Accuracy of Transactions** | Pearson Correlation: 1  
Sig. (2-tailed): .  
N: 406  
**.586*** | .  
406  
.000  
406 |
| **Overall Satisfaction of FFFCU** | Pearson Correlation: .586***  
Sig. (2-tailed): .000  
N: 406  
.  
406 | 1  
406  
.  
406 |

*** Correlation is significant at the 0.01 level (2-tailed).
Question 12.5

Variables Entered/Removed\textsuperscript{b}

<table>
<thead>
<tr>
<th>Model</th>
<th>Variables Entered</th>
<th>Variables Removed</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Accuracy of Transactions</td>
<td>.</td>
<td>Enter</td>
</tr>
</tbody>
</table>

\textsuperscript{a} All requested variables entered.

\textsuperscript{b} Dependent Variable: Overall Satisfaction of FFCU

Model Summary

<table>
<thead>
<tr>
<th>Model</th>
<th>R</th>
<th>R Square</th>
<th>Adjusted R Square</th>
<th>Std. Error of the Estimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>.586*</td>
<td>.343</td>
<td>.342</td>
<td>.783</td>
</tr>
</tbody>
</table>

\textsuperscript{a} Predictors: (Constant), Accuracy of Transactions
### ANOVA

<table>
<thead>
<tr>
<th>Model</th>
<th>Sum of Squares</th>
<th>df</th>
<th>Mean Square</th>
<th>F</th>
<th>Sig.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regression</td>
<td>129.520</td>
<td>1</td>
<td>129.520</td>
<td>211.321</td>
<td>.000&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>Residual</td>
<td>247.613</td>
<td>404</td>
<td>.613</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>377.133</td>
<td>405</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<sup>a</sup> Predictors: (Constant), Accuracy of Transactions

<sup>b</sup> Dependent Variable: Overall Satisfaction of FFFCU

### Coefficients

<table>
<thead>
<tr>
<th>Model</th>
<th>Unstandardized Coefficients</th>
<th>Standardized Coefficients</th>
<th>t</th>
<th>Sig.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>B</td>
<td>Std. Error</td>
<td>Beta</td>
<td></td>
</tr>
<tr>
<td>1 (Constant)</td>
<td>1.923</td>
<td>.244</td>
<td></td>
<td>.000</td>
</tr>
<tr>
<td>Accuracy of Transactions</td>
<td>.837</td>
<td>.044</td>
<td>.586</td>
<td>.000</td>
</tr>
</tbody>
</table>

<sup>a</sup> Dependent Variable: Overall Satisfaction of FFFCU
Question 12.6

Analyze → Regression → Linear → Dependent (Q8) → Independents (Q2 - Q7) → OK
<table>
<thead>
<tr>
<th>Model</th>
<th>Variables Entered</th>
<th>Variables Removed</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Methods Used to Access Account, Accuracy of Transactions, Info on Special Promotions, Rating of FFFCU Product Knowledge, Products and Services, Info on Products and Services^a</td>
<td></td>
<td>Enter</td>
</tr>
</tbody>
</table>

^a All requested variables entered.

b Dependent Variable: Overall Satisfaction of FFFCU
### Model Summary

<table>
<thead>
<tr>
<th>Model</th>
<th>R</th>
<th>R Square</th>
<th>Adjusted R Square</th>
<th>Std. Error of the Estimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>.798*</td>
<td>.637</td>
<td>.632</td>
<td>.585</td>
</tr>
</tbody>
</table>

a. Predictors: (Constant), Methods Used to Access Account, Accuracy of Transactions, Info on Special Promotions, Rating of FFFCU Product Knowledge, Products and Services, Info on Products and Services

### ANOVA

<table>
<thead>
<tr>
<th>Model</th>
<th>Sum of Squares</th>
<th>df</th>
<th>Mean Square</th>
<th>F</th>
<th>Sig</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regression</td>
<td>240.375</td>
<td>6</td>
<td>40.063</td>
<td>116.885</td>
<td>.000*</td>
</tr>
<tr>
<td>Residual</td>
<td>136.756</td>
<td>399</td>
<td>.343</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>377.133</td>
<td>405</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

a. Predictors: (Constant), Methods Used to Access Account, Accuracy of Transactions, Info on Special Promotions, Rating of FFFCU Product Knowledge, Products and Services, Info on Products and Services

b. Dependent Variable: Overall Satisfaction of FFFCU
EXCEL

Question 10.1

Add column “Index” -> Type Formula “=(Q2+Q3+Q4+Q5+Q6+Q7)/6)” -> Drag the formula for whole column

Question 10.2

Add column “New_Age” Type Formula
“(=IF(P8=5,5,IF(P8=4,4,IF(P8=3,3,IF(P8=2,2,IF(P8=1,2,2)))))” → drag the formula for whole column
Question 11.1

Tools → Data analysis → Histogram → OK → Input Q8 (J2-> J407) → Output options
→ New workbook → cumulative percentage → Chart output → OK

<table>
<thead>
<tr>
<th>Bin</th>
<th>Frequency</th>
<th>Cumulative %</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8</td>
<td>1.97%</td>
</tr>
<tr>
<td>1.25</td>
<td>0</td>
<td>1.97%</td>
</tr>
<tr>
<td>1.5</td>
<td>0</td>
<td>1.97%</td>
</tr>
<tr>
<td>1.75</td>
<td>0</td>
<td>1.97%</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>2.71%</td>
</tr>
<tr>
<td>2.25</td>
<td>0</td>
<td>2.71%</td>
</tr>
<tr>
<td>2.5</td>
<td>0</td>
<td>2.71%</td>
</tr>
<tr>
<td>2.75</td>
<td>0</td>
<td>2.71%</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>3.69%</td>
</tr>
<tr>
<td>3.25</td>
<td>0</td>
<td>3.69%</td>
</tr>
<tr>
<td>3.5</td>
<td>0</td>
<td>3.69%</td>
</tr>
<tr>
<td>3.75</td>
<td>0</td>
<td>3.69%</td>
</tr>
<tr>
<td>4</td>
<td>29</td>
<td>10.84%</td>
</tr>
<tr>
<td>4.25</td>
<td>0</td>
<td>10.84%</td>
</tr>
<tr>
<td>4.5</td>
<td>0</td>
<td>10.84%</td>
</tr>
<tr>
<td>4.75</td>
<td>0</td>
<td>10.84%</td>
</tr>
<tr>
<td>5</td>
<td>112</td>
<td>38.42%</td>
</tr>
<tr>
<td>5.25</td>
<td>0</td>
<td>38.42%</td>
</tr>
<tr>
<td>5.5</td>
<td>0</td>
<td>38.42%</td>
</tr>
<tr>
<td>5.75</td>
<td>0</td>
<td>38.42%</td>
</tr>
<tr>
<td>More</td>
<td>250</td>
<td>100.00%</td>
</tr>
</tbody>
</table>
Question 11.2

Tools → Data Analysis → Descriptive Statistics → Input → Input Range Q8 (J2→J407) → Grouped by → Columns → Output Options → New Workbook → OK
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean</td>
<td>5.42364532</td>
</tr>
<tr>
<td>SE</td>
<td>0.047891313</td>
</tr>
<tr>
<td>Median</td>
<td>6</td>
</tr>
<tr>
<td>Mode</td>
<td>6</td>
</tr>
<tr>
<td>SD</td>
<td>0.964983215</td>
</tr>
<tr>
<td>Sample Variance</td>
<td>0.931192605</td>
</tr>
<tr>
<td>Kurtosis</td>
<td>7.855549141</td>
</tr>
<tr>
<td>Skewness</td>
<td>-2.524427322</td>
</tr>
<tr>
<td>Range</td>
<td>5</td>
</tr>
<tr>
<td>Minimum</td>
<td>1</td>
</tr>
<tr>
<td>Maximum</td>
<td>6</td>
</tr>
<tr>
<td>Sum</td>
<td>2202</td>
</tr>
<tr>
<td>Count</td>
<td>406</td>
</tr>
</tbody>
</table>
Question 11.3

Data → Pivot Table and Pivot Chart Wizard → Pivot Table → Next Range → Whole Data (A1→T407) → Next → New Worksheet → Layout → Drag Q14 in row → Drag Q10 in column → Drag Case in Data → Double click on case → Subtotals → Click on Count → OK → OK
Count of Case

<table>
<thead>
<tr>
<th>Q14</th>
<th>Q10</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>28</td>
<td>18</td>
</tr>
<tr>
<td>3</td>
<td>86</td>
<td>67</td>
</tr>
<tr>
<td>4</td>
<td>30</td>
<td>48</td>
</tr>
<tr>
<td>5</td>
<td>35</td>
<td>85</td>
</tr>
</tbody>
</table>
Question 12.1

Add Column “Dummy” and fill with “5” → Tools → Data analysis → T-test : Paired two sample for means → OK → Input → Variable 1 Range: Q8 (J2 -> J407) → Variable 2 Range: “Dummy” (V2 -> V407) → Alpha : 0.05 → Output options → New workbook → OK

<table>
<thead>
<tr>
<th>Variable 1</th>
<th>Variable 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean</td>
<td>5.42364532</td>
</tr>
<tr>
<td>Variance</td>
<td>0.931192605</td>
</tr>
<tr>
<td>Observations</td>
<td>406</td>
</tr>
<tr>
<td>Pearson Correlation</td>
<td>#DIV/0!</td>
</tr>
<tr>
<td>Hypothesized Mean Difference</td>
<td>0</td>
</tr>
<tr>
<td>df</td>
<td>405</td>
</tr>
<tr>
<td>t Stat</td>
<td>8.845974253</td>
</tr>
<tr>
<td>P(T&lt;=t) one-tail</td>
<td>1.41745E-17</td>
</tr>
<tr>
<td>t Critical one-tail</td>
<td>1.648624694</td>
</tr>
<tr>
<td>P(T&lt;=t) two-tail</td>
<td>2.8349E-17</td>
</tr>
<tr>
<td>t Critical two-tail</td>
<td>1.965838614</td>
</tr>
</tbody>
</table>
Question 12.2

Data → Sort → Sort by Q9 → Ascending → OK → Tools → Data Analysis → T-test → Two Sample Assuming Equal Variances → Input → variable 1 Range: Q8 (J2 -> J286) → Variable 2 Range: Q8 (J287 -> J407) → Alpha : 0.05 → Output options → New Workbook → OK
### t-Test: Two-Sample Assuming Equal Variances

<table>
<thead>
<tr>
<th></th>
<th>Variable 1</th>
<th>Variable 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean</td>
<td>5.396491228</td>
<td>5.487603306</td>
</tr>
<tr>
<td>Variance</td>
<td>0.944353842</td>
<td>0.901928375</td>
</tr>
<tr>
<td>Observations</td>
<td>285</td>
<td>121</td>
</tr>
<tr>
<td>Pooled Variance</td>
<td>0.931752218</td>
<td></td>
</tr>
<tr>
<td>Hypothesized Mean Difference</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>df</td>
<td>404</td>
<td></td>
</tr>
<tr>
<td>t Stat</td>
<td>0.869917026</td>
<td></td>
</tr>
<tr>
<td>P(T&lt;=t) one-tail</td>
<td>0.192431154</td>
<td></td>
</tr>
<tr>
<td>t Critical one-tail</td>
<td>1.64863405</td>
<td></td>
</tr>
<tr>
<td>P(T&lt;=t) two-tail</td>
<td>0.384862307</td>
<td></td>
</tr>
<tr>
<td>t Critical two-tail</td>
<td>1.965853199</td>
<td></td>
</tr>
</tbody>
</table>

---

Copyright © 2015 Pearson Education, Inc.
Question 12.3

Tools → data analysis → T-test: Paired two sample for means → Input → variable 1
Range: Q2 (D2 -> D407) → Variable 2 Range: Q3 (E2 -> E407) → Alpha: 0.05 →
Output options → New Workbook → OK
t-Test: Paired Two Sample for Means

<table>
<thead>
<tr>
<th></th>
<th>Variable 1</th>
<th>Variable 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean</td>
<td>5.362068966</td>
<td>5.261083744</td>
</tr>
<tr>
<td>Variance</td>
<td>0.91302682</td>
<td>0.978580551</td>
</tr>
<tr>
<td>Observations</td>
<td>406</td>
<td>406</td>
</tr>
<tr>
<td>Pearson Correlation</td>
<td>0.576303367</td>
<td></td>
</tr>
<tr>
<td>Hypothesized Mean</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>Difference</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>df</td>
<td>405</td>
<td></td>
</tr>
<tr>
<td>t Stat</td>
<td>2.271959027</td>
<td></td>
</tr>
<tr>
<td>P(T&lt;=t) one-tail</td>
<td>0.011806341</td>
<td></td>
</tr>
<tr>
<td>t Critical one-tail</td>
<td>1.648624694</td>
<td></td>
</tr>
<tr>
<td>P(T&lt;=t) two-tail</td>
<td>0.023612683</td>
<td></td>
</tr>
<tr>
<td>t Critical two-tail</td>
<td>1.965838614</td>
<td></td>
</tr>
</tbody>
</table>
Question 12.4

Group Q4 & Q8 → Tools → Data Analysis → Correlation → Input Range: Q4 & Q8 (F2->G407) → Grouped By: Columns → Output Options: New Workbook → OK

<table>
<thead>
<tr>
<th></th>
<th>Column 1</th>
<th>Column 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column 1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Column 2</td>
<td>0.586031</td>
<td>1</td>
</tr>
</tbody>
</table>
Question 12.5

Tools $\rightarrow$ Data Analysis $\rightarrow$ Regression $\rightarrow$ Input Y Range : Q8 (J2->J407) $\rightarrow$ Input X Range : Q4 (F2->F407) $\rightarrow$ Output Options : New Workbook $\rightarrow$ OK
**SUMMARY OUTPUT**

<table>
<thead>
<tr>
<th>Regression Statistics</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple R</td>
<td>0.586031</td>
</tr>
<tr>
<td>R Square</td>
<td>0.343432</td>
</tr>
<tr>
<td>Adjusted R Square</td>
<td>0.341807</td>
</tr>
<tr>
<td>Standard Error</td>
<td>0.782882</td>
</tr>
<tr>
<td>Observations</td>
<td>406</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ANOVA</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>df</td>
<td>SS</td>
</tr>
<tr>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Regression</td>
<td>1</td>
</tr>
<tr>
<td>Residual</td>
<td>404</td>
</tr>
<tr>
<td>Total</td>
<td>405</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Coefficients</th>
<th>Standard Error</th>
<th>t Stat</th>
<th>P-value</th>
<th>Lower 95%</th>
<th>Upper 95%</th>
<th>Lower 95.0%</th>
<th>Upper 95.0%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>1.923371</td>
<td>0.2439</td>
<td>7.885887</td>
<td>2.94E-14</td>
<td>1.443899</td>
<td>1.443899</td>
<td>2.402843</td>
</tr>
<tr>
<td>X Variable 1</td>
<td>0.636699</td>
<td>0.043799</td>
<td>14.53688</td>
<td>8.3E-39</td>
<td>0.550597</td>
<td>0.550597</td>
<td>0.722801</td>
</tr>
</tbody>
</table>
Question 12.6

Tools → Data analysis → Regression → Input Y Range: Q8 (J2->J407) → Input X Range: Q2-Q7 (D2->I407) → Output Options : New workbook → OK
### SUMMARY OUTPUT

#### Regression Statistics

<table>
<thead>
<tr>
<th></th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple R</td>
<td>0.798358</td>
</tr>
<tr>
<td>R Square</td>
<td>0.637375</td>
</tr>
<tr>
<td>Adjusted R Square</td>
<td>0.631922</td>
</tr>
<tr>
<td>Standard Error</td>
<td>0.58545</td>
</tr>
<tr>
<td>Observations</td>
<td>406</td>
</tr>
</tbody>
</table>

#### ANOVA

<table>
<thead>
<tr>
<th></th>
<th>df</th>
<th>SS</th>
<th>MS</th>
<th>F</th>
<th>Significance F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regression</td>
<td>6</td>
<td>240.3751</td>
<td>40.06251</td>
<td>116.8849</td>
<td>1.07E-84</td>
</tr>
<tr>
<td>Residual</td>
<td>399</td>
<td>136.7579</td>
<td>0.342752</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>405</td>
<td>377.133</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Coefficients

<table>
<thead>
<tr>
<th>Coefficient</th>
<th>Standard Error</th>
<th>t Stat</th>
<th>P-value</th>
<th>Lower 95%</th>
<th>Upper 95%</th>
<th>Lower 95.0%</th>
<th>Upper 95.0%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>0.413</td>
<td>0.211</td>
<td>1.959</td>
<td>-0.001</td>
<td>0.827</td>
<td>-0.001</td>
<td>0.827</td>
</tr>
<tr>
<td>X Variable 1</td>
<td>0.156</td>
<td>0.041</td>
<td>3.791</td>
<td>0.075</td>
<td>0.237</td>
<td>0.075</td>
<td>0.237</td>
</tr>
<tr>
<td>X Variable 2</td>
<td>0.290</td>
<td>0.043</td>
<td>6.771</td>
<td>0.206</td>
<td>0.374</td>
<td>0.206</td>
<td>0.374</td>
</tr>
<tr>
<td>X Variable 3</td>
<td>0.149</td>
<td>0.044</td>
<td>3.375</td>
<td>0.062</td>
<td>0.235</td>
<td>0.062</td>
<td>0.235</td>
</tr>
<tr>
<td>X Variable 4</td>
<td>0.242</td>
<td>0.065</td>
<td>3.743</td>
<td>0.115</td>
<td>0.369</td>
<td>0.115</td>
<td>0.369</td>
</tr>
<tr>
<td>X Variable 5</td>
<td>-0.098</td>
<td>0.064</td>
<td>-1.545</td>
<td>-0.224</td>
<td>0.027</td>
<td>-0.224</td>
<td>0.027</td>
</tr>
<tr>
<td>X Variable 6</td>
<td>0.212</td>
<td>0.032</td>
<td>6.569</td>
<td>0.149</td>
<td>0.276</td>
<td>0.149</td>
<td>0.276</td>
</tr>
</tbody>
</table>